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Summary

This report describes the activities of the nuclear physics group at Mississippi State University,

which were performed under contract DE-FG05-92ER40726 with the Department of Ener~. Under the

contract, the nuclear physics group at MSU provided leadership for the Gammasphere Software

Working Group (SWG) and developed software and software standards. The SWG held four workshops

during the term of the contract to inform committee members and interested parties of development in

software and computer technologies and summaries of the presentations and discussions were compiled
....—.— .. ...

for distribution. These summaries have been distributed to interested members of the nuclear physics

community and copies are included with this report.

SWG subcommittees were organized to address specific issues and reports were given to the fill

SWG at each meeting. The subcommittee on a “standard format for histogram data” developed a format

that was presented to the Gammasphere Users’ Group and has been provided to interested parties. Other

subcommittees were organized to address issues of parallel computing and graphical user interfaces at

GammaSphere. We worked closely with Robert Varner and Bill Milner at ORNL in adapting and testing

the ORNL histogram dkplay software (UPAK) for use on SPARC-based workstations. The software

was ported by O?INL staff to the Solaris OS and tests were run at MSU. We also investigated ways to

enhance the OpenLook compatibility and user interface of the ORNL display package.

The SWG interacted closely with researchers at Lawrence Berkeley Laboratory (LBL). A

Mississippi State University (MSU) graduate student, Pete Varmette, worked at LBL during the summer

of 1992 and assisted Robert Belshe in the development of the GammaSphere Liquid Nitrogen Control

System. Mr. Belshe sat on the research committee to review Mr. Varmette’s master thesis, which

contains a fill description of this work and is included with this report.

Graduate, undergraduate and high school students participated in the GammaSphere Software

project at MSU. Three graduate students and an undergraduate have been partially funded by the

project. A very exciting element of our research effort was the involvement of high school students at

the Mississippi School of Mathematics and Science. Our research program provided both challenge and

a unique experience to the students who participated.



I. Introduction

The nuclear physics group at Mississippi State University has grown since this project started.

Dr. Wenchao Ma and Dr. Jeff Winger joined our group in 1994 and each has received DOE awards to

for nuclear structure research programs. Both were awarded tenure this year. In the fhll of last year we

added Jim Dunne to our staff as an assistant professor. Dr. Dunne is developing a research program at

the Thomas Jefferson National Accelerator facility. In 1993 Dr. Piercey became Head of the

Department of Physics and Astronomy and is now primarily involved with the administration of the

~ department. Our Engineering Physics Ph.D. degree program continues -to~rosper and the nuclear
.—-.

physics research programs are responsible for attracting many or our best graduate students. The

Physics building is undergoing a 6.5 M$, state funded, renovation. New labs, a computer room,

graduate student offices, and faculty offices for the nuclear group are being constructed in a suite on the

fust floor of the newly renovated building. The renovation is to be completed in the summer of 2000.

During the course of this project, we made significant contributions in several areas by: chairing

the GammaSphere Software Working Group; organizing GammaSphere software issues workshops;

establishing a nuclear computing facility at Mississippi State University; participating in software

development at Lawrence Berkeley Laboratory; developing a common data file format (CHO);

developing a modular application for data analysis and manipulation (MADAM) and working with

scientists to adapt the ORNL UPAJS software to run at GammaSphere. We have also participated in

several nuclear physics experiments and have co-developed anew numerical scheme for a high-speed,

simulation of high-energy, heavy-ion collisions. Much of this work has been reported at various

meetings and conl?erences.

In our role as Software Working Group (SWG) chair, we organized four major workshops and

met with individual committee members on an as needed basis. Subcommittees were formed to address

specific issues. Progress was periodically reported at the Gammasphere Users’ Group Meeting where

the input of the members was solicited.

We worked with scientists at OKNL to adapt the histogram display software (UPAK) to run at

Gammasphere on a distributed system of SPARC-based, SUN workstations. We managed to make a



large portion of the UPAK software work on our SPARC-based machines and characterized

compatibility issues in a report to ORNL scientists. We also investigated methods to enhance the

Gamamsphere user interface by adding an OpenLook control window in a non-intrusive way.

Two graduate students worked on GammaSphere software issues. Dr. Pete Varmette spent the

summer of 1992 at Lawrence Berkeley Laboratory working with LBL researchers to develop the liquid

nitrogen fill system for the GammaSphere. He was also involved in the development of data formats and

testing of the UPAK software from ORNL. Dr. Varmette will finished his masters’ degree in May of

r 1993 and his Ph.D. in 1996 before taking a post doc position at the Neils Bohr Institute in Copenhagen.
.-—-

Dr. Anita Trivedi worked on the UPAK tests for ORNL and finished here Ph.D. in relativistic

hydrodynamics in December of 1994 before taking a post doc position at Vanderbilt. Hazem Tleimat

continued work on relativistic hydrodynamic simulations.

Mr. Larry G. Gariepy was an undergraduate student who did a special project in our group. His

project involved the study of message passing techniques in Solaris, the SUN operating system.

Message passing techniques were one of the techniques used to enhance the interoperability of the

Garnmasphere software.

Two high school students from the Mississippi School for Math and Science, Jason Keller and

Arun Sridharan, worked with our group. They spent one afternoon per week working at MSU to

develop UNIX techniques for process control. The work is important for understanding how software

processes may be controlled in a multitasking environment and provided the students with truely unique

research experiences.



II. A UNIX-Based Computing Facility

With the support of the Department of Physics and Astronomy and the College of Arts &

Science at Mississippi State University, the nuclear physics group developed at UNIX-based computing

facility for data analysis and software development. The facility is normally housed in a dedicated room

in the physics building and consists of several SPARC stations, and peripherals. The facility is

connected to the campus network, which provides access to the Mississippi State University NSF

Engineering Research Center of Excellence (ERC), the Diagnostic Instrunmniation and Analysis .. -—.
,

Laboratory (DIAL, and the Nuclear Physics community.

The Mississippi State University ERC has provided resources and expertise in the areas of

application development parallel programming and data visualization. With nearly 200 SUN

workstations and numerous other UNIX-based computer systems from HP, IBM and SGI, the ERC

represents one of the best-equipped computer resources in the southeast. The ERC hosted our first

Gammasphere Software Working Group meeting and provided several expert speakers.

In addition to providing general computing and project management resources, the new

computing facility was used to develop the common histogram object format (CHO) and as a test stand

for the ORNL UPAK software. A full example application (MADAM) was developed to display and

manipulate CHO data in the Open Look windowing environment. The draft CHO format and the

routine library are available to anyone who has an interest in GammaSphere software.

The new computer facility has also been the primary mechanism for the involvement of

graduate, undergraduate and high school students in our research project. Access to the Internet has

been essential in coordinating our interaction with Software Working Group activities.

. -.,. ,- - ‘T y%--=T-c?,- ,Y,.-T--~-~ -- ~. .,C7.7.. ..%..- . i .:,.? .?.--Y2T5.5 -t ‘.x3rzT- 7,-7.. - .
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III. Activities of the Software Working Group

The GammaSphere Software Working Group (SWG),was established by the director of the

Gamrnasphere project to: “generate software that will be usefi.d in GammaSphere operation, data

acquisition, and/or data analysis and to interact with GammaSphere management and to develop an

effective interface for user access and use of the Gammasphere computer facilities.” The committee

organized four software development workshops to inform the membership of the state of this rapidly

changing field and to foster interactions between the membership so that each might learn from what the
.-.

‘ others were doing and learning. The first SWG Software issues Workshop was held at Mississippi State

University on June 3-5, 1992. The second workshop was held at the APS Nuclear Physics Division

meeting in Santa Fe, New Mexico on October 14, 1992. The third workshop was held on July 29-30,

1993 at Lawrence Berkeley Laboratory. The fourth workshop was held at the Continuous Electron

Beam Accelerator Facility (CEBAF, now Jefferson Lab) on October 24-25, 1994 during the DNP

meeting.

Three important subcommittees were formed to address areas of interest. The subcommittee on

Data Formats developed a histogram file format (CHO) to encourage data sharing and tool sharing. The

subcommittee on parallel programming traced developments in distributed parallel systems, which could

impact the use of the Garnmasphere computer system and the future development of software in the

nuclear physics community. The subcommittee on Graphical User Interface issues advised ORNL staff

during the porting of the ORNL software to the LBL distributed SUN-based, OpenLook compatible

package. The proceedings of the SWG meetings, the draft CHO specification and the MADAM

application were made available to the SWG and the community at large via a web site maintained by

the nuclear physics group at MSU.



In addition to the work with the SWG, the MSU nuclear physics group was involved in basic research in

nuclear physics and the development of nuclear instrumentation. Three Ph.D. degrees were awarded to

students who were supported in part under this contract.

The final sections of this report includes abstracts, publications and other written documents

resulted from our research. Also provided with this report, please find four additional documents:

(1) Summary and Presentations of the First GammaSphere Software Issues Workshop

(2) Summary and Presentations of the Second Gammasphere Software Issues Workshop

(3) Summary and Presentations of the Third Gammasphere Software Issues Workshop

(4) Handouts from the fourth GammaSphere Software Issues Workshop

that

. . . .. .



IV. Development of a Common Histogram Object

One of the goals of the SWG was to encourage the nuclear physics community to contribute to the

development of high quality software for the Gamrnasphere. The absence of a standard data format was

clearly identified as one of the primary obstacles to sharing the software that already existed and the

development of new software tools. To study this situation and to adopt or develop a data format that

could serve the community, the subcommittee for a histogram standard was formed. With the help of

this committee and others in the nuclear physics community, we developed-zcommon histogram object ..—.-
,

(CHO) that defines a file format and provides for an object orientated programming model. The CHO

file format consists of a list of self-describing records. Each record is identified by a tag and contains

the record size. In addition to the data itself, these records speci~ such things as display characteristics,

calibrations, annotations, regions, markers, sort conditions, etc. Records and record fields are provided

to support graphical user interfaces and heterogeneous distributed systems. The CHO also supports

event-by-event data acquisition by providing for “intelligent” histogram objects that can accept event

record buffers and sort the events based on Condition and Region records.

FaH
“PARM”
“CALB”
“REGN”
“MARK”
“coND”

I “ANOT”

The CHO file format provides for associated structures which support display and analysis



The CHO file is a list of self-identifying elements or records. Each record has a type and a size. This

allows an application program to check for record types that it knows and skip those that it does not

need. For example, an application tool, which analyzes data in “batch” mode, may not need information

about how to display the data. However, a plotting or drawing program would need this information. A

block diagram of a CHO file is shown in the figure above. The “DATA” record contains the actual

histogram data as well as information on the byte order, word size and data lengths. The “DSPL” record

contains the irdiormation required to draw the “counts” axis of the histogram. This includes the
.— .. ----

minimum and maximum values to display symbol and color information. The “PARM” record includes

similar information about the channel axes. There will usually be a “PARM” record for each of the

dimensions of the histogram. “CALB>’records provide calibration information for each of the channel

axes. The “MARK” and “REGN” records define markers and regions in the histogram. There maybe

several of each of these in a CHO object. The “COND” record is a set of conditions or filters, which

regulate how blocks of events are sorted. A condition requires that a particular parameter set be

contained in one or more histogram regions. The “ANOT” records are used to add annotations to any of

the CHO records. Additional details are presented in the attached draft specification.



V. Development of a Modular Application for Data Analysis and
Manipulation (MADAM)

We also developed a sample application, MADAM, which utilizes a library of CHO subroutines

to aid in implementing the CHO model. The example application allows the user to open, display and

manipulate CHO histograms. The UNIX implementation uses the motif interface and can be used with

SUN OS, Solaris and LINUX. The source for MADAM is ANSI-c and POSIX compliant. The main

MADAM window provides a workspace for interacting with the data and with the UNIX shell. .. —-

MADAM is also highly modular and can be extended by adding filter and analysis components. Filter

components allow MADAM to open data in other file formats. Analysis components add additional

features to the application. Both types of components can be written in standard C. A fuller description

of MADAM was included in Dr. Varmette’s Ph.D. desertation and is included with this report.

MADAM and the draft CHO specification are available to interested parties by contacting the MSU

nuclear Physics Group,



VI. Other Activities

Other activities of the MSU nuclear group which were in p@ supported by this project include: Testing

the ORNL UPAK software as it was ported to Solaris and nuclear structure studies.

As a part of the general agreement to development the GammaSphere, ORNL was tasked to provide a

histogramming software package (UPAK) to the GammaSphere facility. The MSU nuclear group

assisted by running formal tests at MSU on the targeted SPARC-based platforms. The tests were——

‘ reported back to ORNL staff for consideration in the porting effort.

In collaboration with the MSU’S, NSF-Funded, Engineering Research Center we have developed a

technique to simulate the collision of high-energy, Heavy-ions. The technique integrates the advanced

grid generation tools from the ERC with the equation of state for a high-temperature nuclear fluid.

Adaptive grid techniques make the simulation very efficient and the results are consistent with those

reported by others.

We have been involved in a number of other studies as indicated in the list of papers and abstracts.



1 L’ Abstract Submitted

for the Oak Ridcre Meeting of The

American Physical Society

.November 12-15. 1992
Meeting Date

Suggested title of session
in which paper should be placed
Instrumentation in Software

Physics and Astronomy
Classification Scheme
Number

AUniversal H~tomam Obiekt For Nuclear Science. RODNEYB.
PIERCEY, Mississippi State University ROBERT BELSHE,”_Lawerence
BerkelevLaboratoty RANDYMACLEOD, AE~andROBERT VARNER,
Oak Rid~e National Laborato ry-l%e histogram is the basic data product of
mostnuclear and high-energy research efforts. While data from user facilities
must often beretumed to member institutions for analysis and/or inclusion in
reports and manuscripts, there is no single histogram file format that has been
adopted for widespread use. The existence of many different histogram formats
makes sharing data unnecessarily complex and time consuming. Translation of
histogram data is generally the responsibility of individual researchers and often
results in duplicated effort. A standard format would save many hours of
research time and promote data sharing. The development of the
GammaSphere facility software provides an opportunity to introduce a standard
histogram architecture which could seine many users in the nuclear and high-
energy communiry.

We are developing a universal histogram object (uHO) that defines a file
format and suggests an object oriented behavior for the histogram data. While
the UHO must enforce specific file formats, it is not meant to impose a specific
implementation of its procedures and leaves room for an arbitrary graphical user
interface (GUI) or window-manager policy. The UHO file format consists of a
list of self-identifying records which describe the data size, data formats plotting
options, etc. A simple application to demonstrate the UHO is currentIy under
development on a UNm Workstaticm. .

( ) Prefer Poster Session
(X) Prefer Standard Session
( ) No Preference

-----

Signatu# of APS M

Rodney B. Piercey

Same name typewritten

Mississippi State University

Address

P.O. Drawer 5167
Mississippi State Univ.
Miss”. State, MS 39762
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Abstract Submitted

for the Oak Ridqe Meeting of The

American Physical Society

November 12-15, 1992
Meeting Date

Suggested title of session Physics and Astronomy
in which paper should be placed classification Scheme
Instrumentation in Software Number

, —

Liquid Nitro!zen ControISvstem. R.A. BELSz Lawren=Berkelev
Laboratow P.G. VARMETTE, Mississippi State Universiw - The
GammaSphere project is wellunderwaywith early implementation set tobegin
early in 1993. & automated liquid nitrogen system has been developed to

“eontrol the cooling of the llOGermainium detectors that comprise thesphere
Theuserinterfa@ to thissystemisa commercialXWkdows displaypackage.

The control system is a combination of hardware and sobare which will
provide flexibility and most important of alI reliability. The control program
consists of five state machines. The state machines run independently of each
other, not being permitted to change the state of another machine. However,
the state machines are alIowed to view the states of the other state machines.
This method reduces the likelihood of undetected programming errors, and
makes source code maintenance relatively easy.

( ) Prefer Poster Session
(X) Prefer Standard Session
( ) No Preference

-----

s itted by

aL1.4@z#
I

of APS er

Rodney B. Piercey

Same name typewritten

Mississippi State University

Address

P.O. Drawer 5167
Mississippi State Univ.
Miss. State, MS 39762
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Coulomb excitation studies to high spin in ‘Cm

R B Piercefi$ll, C Michel$?7,.E Grosset, H Emling% D Schwahn%
H J Wollersheim$, J H Hamiltonlj, A V_Ramayyall and N Trautmamll .. ... .
t Pi@= Dep-ent, VanderbiltUniversity,Nashville,TN37235,USA
$GesellschaftfiirSchwenonenforschung,Dannstad~FederalRepublicofGermany
$MissksippiStateUniversity,Missi&ppiState,MS 39762,USA
IIPhysicsDepartment,VanderbdtUniversity,Nashville,TN 37235,USA and
InstitutftkTheoretischePhysilc,Universit?itFrankfurt,6000Frankfurtam Main,
FederalRepublicofGermany
qInstitutforKemchemie,Universi~atMak 650QMainz,FederalRepublicofGermany

Received20January1993

Abstract.Coulombexcitationstudiesof24Cmwerecarriedoutwith5.3MeV u-’‘Pb
projectilesfromtheGSIUNILACA rotationalbandbuiltonthegroundstateof2aCm
hasbeenidentifiedtospin28+anda tentative30+assignmenthasbeenmade.The
angulardependenceoftheyieldsfortransitionsde-excitingIevelsfromspin28+to6+
havebeenmeasuredandusedtosupportthespinandparityassignments.An anomalous
levelspacingisob~ervedabove22+ andisinterpretedas thecrossingof a
rotation-alignedbandathighspin.TheE2matrixelementscomectirrgthestatesofthe
ground-statebandupto28+havebeendeternkedbycomparingtheexperimental
yieldstocalculationsbasedon semi-classicalCoulombexcitationwithsubsequent
gamma-raydecay.The effectoftheexcitationofothercollectivestatesisalso
considered.No strongdeviationofthematrixelementsfromrigid-rotorbehaviourhas
beenseen.

1. Introduction

One of theimportantcharacteristicsforunderstandingthestructhreofdeformed
nucleiisthedegreetowhichtheyfollowthepredictionsofapurerotationalmodel
astheirfrequencyofrotationincreases.A wealthofexperimentaldatahas
accumulatedtoprovidearatherclearpictureofthedominantstructuralfeaturesof
thestateswith1=20 inorneartheyrastbandofwelldeformedrare-earth,
even–evennuclei.lntherare:earthregion,abruptdeviationsfrompurerotor
behaviourareobservedinthelevelspacingsataboutthe12++14+transition(e.g.
‘backbendingofthemomentofinertia’).Thesephenomenaareusuallyunderstood
toresultfromthecrossingofthegroundbandwithrotationalbands“basedon
quasi-particledegreesoffreedom.Detailedcrankedshellmodel(GM) [1] and
crankedHartree-Fock Bogoliubov (cm%?)[2] calculations have demonstrated the
validity of this general picture for the rare-earth nuclei. Likewise, it was important
to test the rotational behaviour and the band-crossing picture up to high spins in the

I actinide nuclei.

~tPresentaddressUniversityLouvain-La-Neuve,Belgium.
, *$PresentaddressUniversittitHeidelberg,FederafRepubficofGermany.

I 0954-38$?3/93/060849+12$07.50~ 1993IOPPubfishingLtd
I
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TEST OFA SYMMETRICAL FOUR-DETECTOR COMPTON POLARIMETER
USING LOW TEMPERATURE NUCLEAR ORIENTATION

J.K.DENG*, J.H.HAMILTON, A.V.RAMAYYA
Physics Department, Vanderbilt University, Nashville, TN 37235, USA

J.RIKOVSKA, N.J.STONE
Joinl Institute for Heavy Ion Research, HHIRF, Oak Ridge, TN 37831, USA
and Physics Department, O#ord University, UK

W.L. CRO~, R.B. PIERCEY, J.C.MORGAN - —

Physics Department, Mississippi State University, MS 39762, USA

and

P.F.MANTICA, Jr.

UNISOR, Oak Ridge Associated Universities, Oak Ridge, TN 37831, USA

A symmetricalfour-detectorComptonpolarimeterwasusedtomeasurethelinear

@arizationofgamma-raysemittedfromnucleiorientedbythehyperfineinteraction

atlowtemperature.Itspolarizationdetecaoneffkiencywasdeterminedintherange

0.3-1.4MeV andcomparedwidtsomeotherpokimeters.

I,, . .. .. .

. ....1

.

.,

h iswellknownthatlinearpolarizationmeasurementsofgammaradiationyieldvitalinformation

aboutmulapolarity,mixingratioandelectricormagneticcharacteroftheradiation.Thedkctional

distribuaonoflinearlypolarizedy-raysdependsuponthetypeoftheradiation(magnetic/electric)and

thusontherelativepsrityofrheinitialandfinrdnuclearstates/1/.Comptonscatteringismostfkquently

usedforthedetectionofy-raypolarization/2,3/sincethedifferentialComptonscatteringcrosssection

isrelativelylargeandpolarizationsensitiveoverawidephotonenergyrange.

Theangulardistributionofy-radiationisgivenby141,

W(6)= I+ ~B,U2A2p2(COSe) (1)

whereBLareorientationparametersdescribingthedegneoforientationoftheparentnucleus,UXare

&orientaaoncoefficientswhichincludetheeffectofanyprecedingradiaaonbetweentheorientedstate

oftheparentnucleusandtheiniaalstateoftheobservedradiationandAL areangulardistribution

coefficientswhichdependoncharacteristicsofay-transition.

Thetheoreticalvalueofthelinearpolarizationforagammatransiaonemittedatangle842 with

*on leavefromDept.ofPhysics,TsinghuaUniversity,Beijing,p.R china.

@J.C.BaltzerA.G.,ScientificPublishingCompany
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, Extensions to the Common Histogram Object Format and the Madam Applica.
; tion.

An extension to the US developed Conimon Histogram Object, CHO, file format has I
been made to include PEAK records, functional MARK, and REGN records. The file
format was originally developed to encourage the nuclear physics community to adapt
a common histogram file format.

A ModularApplicationforDataAnalysisand Manipulation,Madam, originallyde-

velopedfortheGarnmasphereprojecthasbeenfurtherdevelopedforusewithdata.
analysisfromEuroball111and otherarrays.Madam providesan extensibledisplay
andmanipulationpackagebasedon theCHO fileformat.Madam has beencombined
withSpeiosothatotherfileformatscanbe readandmanipulated.Analysismodules
arebeing’developedtomake manipulationofthedataasuserfriendlyaspossible,
includingmany oftheSAP toolsforincreasedfunctionalisty.At itsheart,Madam pro-

videsa Motif based graphical user interface to easily manipulate data.

The Modules of Madam arestandaloneroutineswhicharecompiledintosharedli-
brarieswhichcanbe dynamicallyloadedintomemory and executed. To program a
new module a user would have to have a basic understanding of the CHO file format.
A non-graphical interface has also been developed to execute the modules from the
command line allowing for quicker batch processing of many data files.

. A Search module used to search for rotational patterns in spectra has been developed
based on the concepts of the fluctuation analysis technique.

An Interactive Sorting Machine to efficiently process high fold list mode data di-
rectly into level scheme trees is being developed to work under the Madam framework.
The sorting engine will be a separate process, which communicates to Madam via pipes,
sorting data to shared memory which can then be viewed and manipulated by Madam.

P.G. VA.rmette, (C.J. 13eyer), (R.B. Piercey),M. Bergstr&nandB.Herskind.

The N131TAL Data Analysis Working Group.

The purpose of this project is to facilitate exchange of data and analysis tools between
members of the EUROBALL III project and to develop new methods and techniques
to extract physics information from the new data.

The primary data from EUROBALL, not only exceeds earlier data sets from NORD-



VI. Publications, Abstracts and Presentations

Articles

“TestofaSymmetrical Four-Detector Compton Polarimeter Using Low Temperature Nuclear
Orientation: J.K. Deng, J.H. Hamilton, A.V. Ramayya, J. Ridovsd~ N.J. Stone, W.L. Croft,
R.B. Piercey, J.C. Morgan, P.F. Mantica, Jr., Hyperfine Interactions., pp. 519-524 (1992)

“Coulomb Excitation Studies to High Spin In 248Cm,” R.B. Piercey&C. Michel, E._Grosse, .. ...
H. Emling, D. Schwalm, H.J. Wollersheim, J.H. Hamilton, A.V. Ramayya and N. Trautmann, ~
Phys. G:Nuc1. Part. Phys. lQ, (1993), 849-860.

“Off-Line Nuclear Orientation Studies of 9bMo,”K. Butler-Moore, A.V. Ramayya, J.H.
Hamilton, J.K. Deng, J. Korrnicki, W. Ma, P.F. Mantic% Jr., H.K. Darter, R.B. Piercey, J.C.
Morgan, W.D. Hamilton (To be published).

“Performance of a three-element thin film detector,” Z. Milosevich, M.L. Mug% R.L. Coldwell,
G.J. Barnford, P.S. Haskins and R.B. Piercey, Nucl. Instr. and Meth. in Phys. Res., A320 , pp.
471-478. (1992)

“Computational Simulation of High-Energy Heavy-ion Collisions,” H. Tleimat, R.B. Piercey and
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CHO_INTRO (3) CHO C

NAME
intro - introduction

DESCRIPTION

LIBRARY FUNCTIONS

to the CHO library

cHo_INTRo(3)

This is an introduction to programming with the Common
Histogram Object (CHO) library. The CHO library is a
collection of functions that examine and manipulate data
stored in the format specified by the CHO standard.

The Hist structure defined in cho.h is the method the
library uses to keep track of the CHO objects. The Hist
structure contains pointers to the object structure_s~__or
to linked lists of object structures. The Hist structure
is then passed around to the various functions that
manipulate CHOS.

Several functions also exist to create objects and return
pointers to their location. These object take a Hist
structure as one of their arguments, but they do not
as the new object to the Hist. The Hist structure is
used to determine the rec ID and the rec owner ID.— —

There are three main functions in the library to read in
CHOS from a file. Two of them, cho load arch_numo and
cho load arch nameo load in CHOS f;om a; archive by their
pos?tion–in t~e file or their name. The third function,
cho load choo loads in a singe CHO from a file.— —

The three loading functions do not check to see if the
file is in the correct format. Another function,
cho_check_file (), is provided to check the format of
a particular file. This function should be called first
to examine whether the file is i.nCHO format, if it i.s
archived, and if it is ported correctly.

Another useful function is cho_byteswap choo. This
byte swaps a single CHO file or an arch~ve CHO file
if the PORT record indicates wrong endi.anarchitecture.

In addition to the CHO standard objects, the library
supports a text format that converts an ASCII file
into a CHO. TEXT
TEXT, followed by
lengths and data.
like this:

TEXT 2 512 512
0 1 0 00 1 5634

where the rank is

files should begin with the letters
ASCII integers describing the rank,
For example a TEXT file might begin

55 ....

2, the length of the first parameter is
512, the length of the second parameter is 512, and the
first data element is O. This file should be opened using
the cho_load_choo function. The Hist record will contain
a DATA object describing the TEXT file after the reading



procedure.

FILES
cho .h
li-bcho.a

SEE ALSO
cho(3cho) , cho io(3cho), port(3cho), arch(3cho), data(3cho),
errs(3cho) , pa;m(3cho), sort(3cho), calb(3cho), regn(3cho),
cond(3cho), mark(3cho), dspl(3cho), anot(3cho), text(3cho),
cho_macro(3cho )



CHO(3) CHO C LIBRARY FUNCTIONS

NAME
cho new hist, cho_empty_hist, cho_add_obj ect,
get~uni@e_rec_ID, get_object_ptr, dswab - cho
routines

SYNOPSIS
#include <cho.h>

CHO(3)

Hist

void

void

int

void

void

*cho_new_hist ()

cho_empty_hist (Hist *the hist)—

cho add object (Hist *the hist,——
void *the_obj=ct)

get_unique_rec_ID (Hist *the_hist)

*get_object_ptr (Hist *the_histr
char *type,
int n)

dswab (char *var,
int len)

DESCRIPTION
These are functions that act on CHOS in general, or are
called by other functions acting upon CHOS.

cho new histo callocs a new Hist structure and returns——
a pointer to its location. By using calloc this ensures
that all the variables are already set to NULL.

cho empty histo takes the hist and attempt to free
eve;y non%ll pointer ins~de the structure. It then
re-initializes the variables in the hist to NULL.—

cho add objecto attempts to add the object to the_hist.
The~objSct is identified by its firs; 4 bytes then
the correct variable in the hist is made to point to
the_object. If the first 4–bytes are not recognized as
a valid object type then the function returns with no
change to the hist.—

get_unique_rec_ID() returns searches for a unique record
id within the hist. The first id tried is 1.—

get_object>tro returns the pointer to the nth object
of type in the hist. If the object type is not one that
requires a lin~ed list then the n field is ignored. If
the object pointer is NULL then NULL is returned.

dswabo reorders the bytes in var by swapping the first
with the last, the second with the second to last, and so
on for a byte string of length len. If len is odd then
the middle byte is left alone.



NOTES
cho_empty_histo assumes that the objects the_hist points
to have been malloced, calloced, realloced or memaligned
into existence so that freeo will work properly.

cho_add objecto does not free an existing pointer before
it sets—the new pointer. This leaves the potential for
lost malloced memory segments.

FILES
cho .C the function source.
libcho.a library containing the functions.

SEE ALSO
Intro(3cho), cho_io(3cho), port(3cho), arch(3cho), data(3cho),
errs(3cho), parm(3cho), sort(3cho), calb(3cho), regn(3cho),
cond(3cho), mark(3cho), dspl(3cho), anot(3cho), text(3cho),
cho_macro(3cho )



cHo_Io(3) CHO C LIBRARY FUNCTIONS

NAME
cho check file, cho get arch_num, cho load cho,— — ——
cho load arch num, cho load arch name; cho—writet— — — — — —
cho_byteswap cho, cho read chor cho arch name2num
1/0 function; for CHO~ –

— —

SYNOPSIS
#include <cho.h>

int

int

void

void

void

void

int

void

int

cho check file (char *fname)— —

cho get arch num (char *fname)—— —

cho load cho (Hist *the hist,— —
char *fnameY

cho load arch num (Hist *the hist,— — —
char *fname,
int hist num)—

cho load arch name (Hist *the histt— — —
char *fname,
char *arname)

cho write (Hist *the hist,—
char *fname~
char *mode)

cho_byteswap cho (char *infname,—
char *outfname)

cho read cho (choI”dent*ident,— —
Hist *the hist,
FILE ‘the~file)

cho arch name2num (char *fname,— —
char *arname)

DESCRIPTION
cho check fileo checks the first four characters
fil; to s;e if they match that of a CHO type. If

cHo_Io(3)

of a
the

first tag is a PORT tag then the port record is read
in and compared with a newly created port record. If
the first record tag is ARCH tag or if the first record
tag after a PORT record is an ARCH tag, then the file
is assumes to be a CHO archive. Any other record tag
coming first or after PORT returns the flag for a
single CHO. If the TEXT tag is encountered then
the return value is of a single CHO.

cho get arch numo returns the number of Archived CHOS
fou;d i; fil~ fname. Zero is returned if the file
could not be opened, or if no ARCH records were found.

cho_load_choo load the CHO file fname into the hist.—



If the file could not be opened then the function
returns with no change. After the file is opened,
cho_empty_histo is called on the_hist. Then the
first four bytes are read in to check for the TEXT
tag. If the TEXT tag is encountered then the
load_text_proco is called. Otherwise the choIdent
structure is read in and cho_read_choo is called
to select the proper loading function.

cho load arch numo loads the archive that is hist num
arc;ive ;ecor~s from the beginning of the file. I=
the archive file fname could not be opened then the
function returns with no changes. Cho_empty_histo is
called, then choIdents are read in to skip to the
proper archive. If, after skipping over an archive,
a new ARCH record is not found, then the function
returns. This is what would happen if the hist num
were larger than the number of archives in the ~ile.

cho_load_arch_name( ) works similarly to cho_load_arch_numo 3
except that is loads the first archive found with <.

the name arname.

cho_writeo directly writes form memory every
object in the hist except x refs. The file opening
mode can eith~r be NEW or A~PEND. If the mode is
NEW then the file is created from scratch, erasing
any file that might previously exist there. The
APPEND mode appends the objects in the_hist at the
end of any information that already might exist in
the file. The order in which the objects are written
out is as follows: PORT-> ARCH-> DATA-> ERRS->
DSPL-> PARM-> SORT-> CALB-> REGN-> COND-> MARK->
ANOT . For objects stored in linked lists, the
first object pointed to by the LHEADER is written
first. Then it follows the next fields until
it encounters NULL.

cho_byteswap choo attemps to change the least
and most significant byte ordering of the integers
and floats in the infname file and re-write it to the
outfname file. If either of the files cannot be opened
then zero is returned. Cho_empty_histo is called
then choIdent blocks are read in and byte swapped.
From there a byte swapping function is called for
each object. The only object with byte swapping
functions in this implementation are: PORT, ARCH,
DATA . If an unknown object type is encountered
or if an object without a byte swap function is
encountered, the function returns with a value
of zero. One is returned upon successful execution.

cho_read_choo attempts to call a loading function
for the object described by ident in the_file. If
the object described by ident is not recognized then
the function attempts to skip over the amount of
space described in ident as rec size.—



cho_arch_name2numo works similar to cho_get_arch_numo .
It searches for the archive arname in the file fname
and returns the number of archives deep it is. If
arname is not found then zero is returned.

RETURN VALUES
cho check fileo returns an int based on its analyis
of ~he fiye.

-2 - CHO with an incorrect PORT record
-1 - Non-standard CHO or unknown file type

o- Unable to open the file for reading
1- Single CHO format
2 - Archived CHO format

cho get arch numo returns the number of archives—— —
in the file fname, or O if it finds none.

cho byteswap choo returns 1 upon successful execution
or 6 if an e;ror is encountered.

cho arch name2numo returns the number of archives
dee~ arn~me is in the file fname, or zero if it
is not found or an error is encountered.

NOTES
cho_get_arch_numo, cho_load_choo, cho_load arch numo,
cho load_arch nameo, cho_byteswap_choo , an~ —— —
cho arch name2numo all assume that the files are
alr;ady ~n the proper format and do very little
error checking. The function cho_check_fileo is
supplied for format checking.

cho_load_choo, cho_load_arch_numo ,
cho_load_arch_nameo and cho_byteswap_choo all
call cho_empty_histo erasing any objects that
might already be stored in the hist structure.—

cho read choo assumes that the CHO file is in
goo~ ord~r and if it encounters an object whos
location has already been taken in the_hist, then
it simply stores the new pointer and ignores the
old one.

cho_byteswap_choo does not byte swap the
rec user data field in the choIdent structure.
Thi~ mea~s that float or integer data stored in
the choIdent stucture is unsafe across different
platforms.

FILES
cho io.c source code.
lib;ho.a library containing the functions.

SEE ALSO
Intro(3cho)



cHo_ANoT(3) CHO C LIBRARY

NAME
load_anot_proc - ANOT object

SYNOPSIS

FUNCTIONS

functions

cHo_ANoT(3)

void load_anot_proc (Hist *the hist,
FILE *the_fil~,
choIdent *ident)

DESCRIPTION

FILES

BUGS

load_anot proco mallocs a memory block the size of a
ident->re; size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the_file,
the number of bytes equivalent to:

ident->rec_size - sizeof(choIdent)

are read into the memory block after the ident structure.
Cho_add objecto is then called to add the object to 3
the his~.— x.

cho load snot.c
lib;ho.a–

load anot proco does not check for different versions
than–what–is expected.

SEE ALSO
Intro(3cho)



cHo_ARcH(3) CHO C LIBRARY FUNCTIONS cHo_ARcH(3)

NAME
load_arch_proc, load_arch_bs_proc, cho_creat_arch - ARCH
object functions

SYNOPSIS
void load_arch_proc (Hist *the_hist,

FILE *the file,
choIdent ‘ident)

void load_arch_bs_proc (Hist *the_hist,
FILE *the file,
choIdent ‘ident)

cho ARCH *cho crest arch (Hist *the hist,— — —
char *fname);

DESCRIPTION
load_arch_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the file,
the number of bytes equivalent to:

—

FILES

BUGS

ident->rec size -—

are read into the memory
Cho_add_objecto is then
the hist.

sizeof(choIdent)

block after the ident structure.
called to add the object to

load arch bs proco works similar to load_arch_proco
exce~t th=t It byte swaps the integer and float fields
before returning.

cho crest archo creates a new ARCH record. Malloco
is ~sed t; create a new memory block. Then every field
in the hist except ARCH and PORT, and the archive size
is sum—cd up. If the DATA object is NULL then rec_ID
and rec owner ID are not set. The address of the new
memory ~lock IS returned.

cho load arch.c
cho—arch~c
lib~ho.a

load_arch~roco and load_arch_bs proco do not check
for different versions than what ~s expected.

SEE ALSO
Intro(3cho)

-ix.
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NAME
load_calb_proc - CALB object functions

cHo_cALB(3)

SYNOPSIS
void load_calb_proc (Hist ‘the_hist,

FILE *the_file,
choIdent *ident)

DESCRIPTION
load_calb_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the_file,
the number of bytes equivalent to:

ident->rec size - sizeof(choIdent)—

are read into the memory block after the ident structure.
Cho_add_objecto is then called to add the object to -$
the hist.— ==

FILES

BUGS

cho load calb.c
lib~ho.a–

load_calb_proco does not check for different versions
than what is expected.

SEE ALSO
Intro(3cho)



cHo_coND(3) CHO C LIBRARY

NAME
load_cond_proc - COND object

SYNOPSIS

FUNCTIONS

functions

cHo_coND(3)

void load_cond_proc (Hist *the_hist,
FILE *the_file,
choIdent *ident)

DESCRIPTION

FILES

BUGS

load_cond_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the file,
the number of bytes equivalent to:

—

ident->rec size - sizeof(choIdent)—

are read into the memory block after the ident structure.
Cho_add_objecto is then called to add the object to
the_hist.

3
<.

cho load cond.c
lib=ho.a–

load_cond_proco does not check for different versions
than what is expected.

SEE ALSO
Intro(3cho)



cHo_DATA(3) CHO C LIBRARY FUNCTIONS cHo_DATA(3)

NAME
load_data_proc, load_data_bs_proc, cho_calloc_data,
get_row_ptr, get_parm_len - DATA objedt functions

SYNOPSIS
void load_data_proc (Hist *the_hist,

FILE *the file,
choIdent ~ident)

void load_data_bs_proc (Hist *the_hist,
FILE *the file,
choIdent ‘ident)

cho DATA *cho calloc data (Hist *the hist,— —
‘int rank,
DataFormat wdfmat,
int wdsizet
int *lens)

void *get row ptr (Hist *the histr——
int rowNum)–

int get_parm_len (Hist *the_hist,
short parm_num)

DESCRIPTION
load_data_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the_file,
the number of bytes equivalent to:

ident->rec_size --sizeof(choIdent)

are read into the memory block after the ident structure.
Cho_add_objecto is then called to add the object to
the hist.

load_data_bs proco works similar to load_data_proco
except that ?t byte swaps the integer and float fields
before returning.

cho_calloc_datao creates a new data block using calloco .
The memory block size is calculated using wdsize, lens[]
and rank. If the hist is NULL then the rec_ID is set to 1.
The rec owner ID ~s set to be the same as rec_ID.—

get_row>tro returns the pointer to the first data element
of the specified row. The rows begin counting at O. If
the row is out of rang then NULL is returned.

get_parm_leno returns the channel length of the specified
parm. If parm num is out of range then O is returned.—

FILES
cho load data.c—



cho data.c
lib~ho.a

BUGS
load data_proco and load_data_bs proco” do not check
for ~ifferent versions than what ~s expected.

SEE ALSO
Intro(3cho)



CHO_DSPL (3) CHO C LIBRARY FUNCTIONS cHo_DsPL(3)

NAME
load_dspl_proc, cho_creat_def_dspl, cho get fore color,
cho set fore color - DSPL object func~ion~ –— — —

SYNOPSIS
void load_dspl_proc (Hist *the_hist,

FILE *the file,
choIdent ‘ident)

cho_DSPL *cho_creat_def_dspl (Hist *the_hist)

void cho get fore color (Hist *the hist,—— —
XColor *colorY

void cho set fore color (Hist *the hist,—— —
XColor color ~ttribs)—

DESCRIPTION
load_dspl_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the file,
the number of bytes equivalent to:

—

ident->rec size - sizeof(choIdent)—

are read into the memory block after the ident structure.
Cho add_objecto is then called to add the object to
the–hist.—

cho crest def dsplo mallocs a new DSPL decord and set
the–field= ac~ording to default values. The pointer
to the new record is re~urned.

cho get fore coloro set the rgb values in color
acc~rdi~g to—the DSPL record.

cho_set_fore coloro sets the color values in the DSPL
record accor~ing to the rgb values in color attribs.—

FILES
cho load dspl.c
cho–dspl~c
lib;ho.a

BUGS
load_dspl proco does not check for different versions
than what–is expected.

cho get fore coloro and cho set fore coloro do not check
for–the–exis~ence of a DSPL ~eco~d be?ore getting or setting
the rgb values.

SEE ALSO
Intro(3cho)



cHo_ERRs(3) CHO C LIBRARY

NAME
load_errs_proc - ERRS object

SYNOPSIS

FUNCTIONS

functions

cHo_ERRs(3)

void load_errs_proc (Hist *the_hist,
FILE *the file,
choIdent ‘ident)

DESCRIPTION

FILES

BUGS

load_errs_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the_file,
the number of bytes equivalent to:

ident->rec size - sizeof(choIdent)—

are read into the memory block after the ident structure.
Cho_add_objecto is then called to add the object to
the hist. ~

— =.

cho load errs.c
lib~ho.a–

load errs_proco does not check for different versions
than–what is expected.

SEE ALSO
Intro(3cho)
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NAME
load_mark_proc - MARK object functions

cHo_MARK(3)

SYNOPSIS
void load_mark_proc (Hist *the hist,

FILE *the fil~,
choIdent ‘ident)

DESCRIPTION
load_mark~roco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the_file,
the number of bytes equivalent to:

ident->rec_size - sizeof(choIdent)

FILES

BUGS

are read into the memory block after the ident structure.
Cho_add_objecto is then called to add the object to
the hist.—

cho load mark.c
lib~ho.a–

load mark_proco does not check for different versions
than–what is expected.

SEE ALSO
Intro(3cho)

-5
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CHO_PARM (3) CHO C LIBRARY FUNCTIONS cHo_PARM(3)

NAME
load parm_proc, cho crest def parm - PARM object functions. — —.

SYNOPSIS
void load_parm_proc (Hist *the histr

FILE *the fil~,
choIdent ‘ident)

cho PARM *cho crest def parm (Hist *the hist,— — — ——.
lnt length,
int dim)

DESCRIPTION
load_parm_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the
the

are
Cho

beginning of the new memory block. From the file,
number of bytes equivalent to:

—

ident->rec size - sizeof(choIdent)—

read into the memory block after the ident structure.
_add_objecto is then called to add the object to

the hist.—

cho crest def parmo mallocs a new parm record then sets
the–value: ac~ording to length, dim and default values.

FILES
cho_load_parm
cho_parm.c
libcho.a

BUGS

c

load_parm_proco does not check for different versions
than what is expected.

SEE ALSO
Intro(3cho)



CHO_PORT (3) CHO C LIBRARY FUNCTIONS

NAME
load_port_proc, load_port_bs_proc, cho_check_port,
cho crest port - PORT object functions— —

SYNOPSIS
void load_port_proc (Hist *the_hist,

FILE *the file,
choIdent ‘ident)

void load_port_bs_proc (Hist *the_hist,
FILE *the file,
choIdent ‘ident)

int cho_check_port (Hist *the_hist)

cho_PORT *cho crest port(Hist *the hist)— — —

cHo_PoRT(3)

DESCRIPTION
load_port_proco mallocs a memory block the size of a
cho PORT record and memcpys the ident stucture into
the–beginning of the new memory block. From the file,
the number of bytes equivalent to:

—

sizeof(cho_PORT) - sizeof(choIdent)

are read into the memory block after the ident structure.
Cho_add_objecto is then called to add the object to
the hist.—

load_port_bs proco works similar to load_port_proco
except that ~t byte swaps the integer and float fields
before returning.

cho check~orto tests to see if the PORT record in
the–hist is correct. First calls cho_creat_porto
the= it uses memcmp to compare the two records after
the ident structure in the record. It then returns
the value of the memcmp. A value of zero means the
record is valid. A non-zero value means the record
is incorrect somewhere. If the_hist does not point
to a PORT structure then zero is returned.

cho_creat_porto mallocs a memory segment the size
of a cho PORT record and sets all the fields to
their pr=per values. (see port.h) If the
DATA object in the hist is null then the function
does not try to ge~ a rec_ID or rec_owner_ID.

FILES
cho_load_port .C
cho_port.c
libcho.a

BUGS
load_port_proco and load_port_bs_proco do not check



for different versions than what is expected.

SEE ALSO
Intro(3cho)



cHo_REGN(3) CHO C LIBRARY

NAME
load_regn_proc - REGN object

SYNOPSIS

FUNCTIONS

functions

cHo_REGN(3)

void load_regn_proc (Hist ‘the_hist,
FILE *the file,
choIdent ‘ident)

DESCRIPTION
load_regn_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn?ng of the new memory block. From the file,
the number of bytes equivalent to:

—

ident->rec_size - sizeof(choIdent)

FILES

BUGS

are read into the memory block after the ident structure.
Cho add_objecto is then called to add the object to
the–hist.—

cho load regn.c
lib~ho.a–

load regn proco does not check for different versions
than–what–is expected.

SEE ALSO
Intro(3cho)
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CHO_SORT (3) CHO C LIBRARY FUNCTIONS

NAME
load_sort>roc - SORT object functions

SYNOPSIS
void load_sort_proc (Hist *the_hist,

FILE *the file,
choIdent ‘ident)

cHo_soRT(3)

DESCRIPTION
load_sort_proco mallocs a memory block the size of a
ident->rec size and memcpys the ident stucture into
the beginn~ng of the new memory block. From the fi+~
the number of bytes equivalent to:

—

ident->rec size - sizeof(choIdent)—

are read into the memory block after the ident structure.
Cho_add_objecto is then called to add the object to
the hist.—

FILES
cho load sort.c
lib~ho.a–

BUGS
load_sort_proco does not check for different versions
than what is expected.

SEE ALSO
Intro(3cho)

.-—-
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CHO_MACRO (3)

NAME
cho_get

SYNOPSIS
#include

CHO C LIBRARY FUNCTIONS CHO MACRO(3)—

access to CHO fields

<cl-lo.h>

cho get (Hist *the hist,— —
FIELD,
FLAG)

DESCRIPTION

,

FIELD

cho geto is a macro used to access CHO files wikh-a-Eist
str=cture. The cho_get macro may expand into other macros,
but the only macro a programmer should need to call is
cho_geto with its supporting arguments. This macro system
depends upon ASNI specific standards, and may not work for
some non-ANSI C compilers.

The first arguement should to cho_geto should always be the
Hist structure the FIELD is located in. The second arguement,
FIELD, is the valiable you with to get. The last arguement
is an optional parameter that may be needed to describe FIELD.

If the last optional parameter is not needed the NULL or zero
should be placed there.

DESCRIPTIONS
Field Name FLAG DESCRIPTION TYPE
_________________________________________________________________________

ChoArchName NULL

ChoRank
ChoDataFormat
ChoWordSize NULL
ChoDataCompress
ChoDataRowPtr

ChoDataLength
ChoStartParm
ChoStopParm num
ChoParmIntvlMin
ChoParmIntvlMaj
ChoParmLabel

ChoValMin NULL
ChoValMax NULL
ChoReverseVideo
ChoVertMode NULL
ChoValIntvlMin
ChoValIntvlMaj
ChoGridMode NULL
ChoValLabel NULL

ChoDisplay NULL
ChoWindow NULL

archive name in the ARCH object char *

NULL
NULL
Word
NULL
num

num
num
last
num
num
num

‘Rank of the data choInt
Format of the data DataFormat

size of the data choInt
Compression method of data choInt
pointer to data row num void *

length or parm num int
first channel displayed on parm num choInt

channel displayed on parm num choInt
minor tic interval on parm num choInt
major tic interval on parm num choInt
label for parm num char *

minimum displayed value choInt
maximum displayed value choInt
NULL reverse video flag choInt
vertical drawing mode choInt
NULL minor tic
NULL major tic
grid mode
label for value

display pointer
window number

interval on value axis choInt
interval on value axis choInt

choInt
axis char *

void *
Window



NOTES

FILES

ChoScreenNum NULL screen number int
ChoGC NULL Graphics Context pointer void *

The macro cannot check for errors, so if you try to access an object
that is NULL then you will most likely have the Core Dump Blues.

cho macro.h
cho~h

SEE ALSO
Intro(3cho) — ------
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FMATCHO (1)

NAME
fmatcho

SYNOPSIS
fmatcho

DESCRIPTION
fmatcho
program

CHO UTILITY PROGRAMS

Convert files into a CHO format

FMATCHO(l)

[ -i type ] [ -o type] [ -h ] infile [ outfile ]

converts one data format into another format. The
also byte swaps CHO files.

-i type -- assigns the infile type.
input types are:

spk -- SPK format developed at
Radioactive Beam Facility at Oak
Lab

his -- HIS format developed at
Radioactive Beam Facility at Oak
Lab

Recognised

the Hollifield
Ridge National

the Hollifield
Ridge National

port -- CHO with a bad port record

cho -- Common Histogram Object format

cha -- Common Histogram Object archived format

If the input types are not specified then the program
attempts to guess the format. The routine cho_check fileo
from the CHO library is called to check if the file ~s
is a CHO format. If the format is not CHO then then the
prorgam attempts to guess the format by the infile’s name.
A file ending in .spk of .SPK is guessed to be spk format,
and a file ending in his or .HIS is guessed to be the
his format.

-o type -- assigns the outfile type. Recognised
input types are:

cho -- Common Histogram Object format

cha -- Common Histogram Object archived fo~at

If the output type is not specified then the type is guessed
based on the name outfile. If outfile is not specified either
then the program defaults to cha type output.

If the outfile is not specified the the name is guessed based
on infile, infile type and outfile type.

If the outfile type is cho then the outfile is considered
the name of the directory to store the CHOS in.

-h -- forces the output of CHOS to be in the
current working directory

If the input type and the output type are the same then the



program does nothing.

FILES
fmatcho

SEE ALSO
Intro(3cho)

— ------
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cHo_TExT(3) CHO C LIBRARY FUNCTIONS cHo_TExT(3)

NAME
load_text_proc - TEXT input function

SYNOPSIS
void load_text_proc (Hist *the_hist,

FILE *the_file,
choIdent *ident)

DESCRIPTION
load text_proco reads in ascii words according to the TEXT—
format (see Intro.3cho) and converts them into a DATA object.

FILES

NOTES

cho calloc datao is called to create
cho~add ob~ecto is called to add the—

cho load text.c
lib~ho.a–

the DATA blockfien
DATA object to the_hist.

load text proco assumes that the ascii lengths and data values
conv;rt t; integers.

SEE ALSO
Intro(3cho)



Document describing my alterations to DAMM while implementing
CHO support.

SUMMARY

NOTES

The addition of
the development
the creation of

the CHO format in the DAMM program required
of a standard library of CHO routines and
some “wrapper” routines to interface the

library with the DAMM code. the interfacing routines are
contained within two files:

Ddamm/cho_libc .C
Ddamm/cho_libf .f

.. .—.—
In addition the Makefile file was modified to add the CHO
standard library (libcho.a) and these two object files to
DAMM’s dependencies. Ddamm/cho_libc.c also requires the cho.h
header file to compile properly.

ON MAKEFILE
All the C code describing CHO functions (including cho_libc.c)
requires an ASNI C compiler. In addition, the Makefile for
the standard CHO library (libcho.a) requires a make program
that handles certain special syntax. The platform where these
two requirements become a problem is which the DEC MIPS running
Ultrix. My solution was to use the gnu versions of the compiler
and make program

OSF: MAKE
cc

Ultrix:
cc

SunOS4 :
cc

SunOS5:
cc

Here are my recommendations for each:

- make
- cc

MAKE - gnumake
- gcc

MAKE - make
- acc

MAKE - make
- cc

If the only option for compilation is to use a non–ANSI
compiler and you wish to alter the code for this compiler,
the the majority of alterations would probably need to be
made to the Macro system used by cho.h (described in
cho macro.h) .—

On the sunOS4 system, when the acc compiler is used, the
standard ASNI library needs to be linked in. This is done
by passing the following options to the linker:

-L/usr/lang/SCl.O/ansi_lib -lansi

CHANGES TO EXISTING DAMM CODE
In addition of the new files described in the above summary,
some minor changes were made to the existing damm source.
The following source files were modified:

xdamlibu.f - 3 functions
Xplo. f 2 functions

.--—- 1



xmildo.f - 2 functions

The changes mostly consisted of adding to an IF statement
and adding a small block of code for the CHO format. To
assist in understanding my changes to th”esethree files I
have printed out the SunOS4 versions and highlighted my
changes.

One other important thing to note about the source is that
five new global variables were declared in cho_libc.c. They
are:

N, O, Q, R, S
and their use is contained to the functions described in
the file cho libc.c. —.—

SUPPORT ADDED TO DAMM
A full implementation of CHO was not added, however most of
the important commands now recognise CHO files. The IN
and OU commands will open CHOS for input and output. The
OU command presently uses a cho archive format to output
files. The CHO name is the ID of the hist your saving
appended with the ending .cho (ex: ID = 3, NAME = 3.cho) .
This CHO is then written to the archive opened with OU.

In reading CHOS I had to sacrifice an important style
for accessing histograms in a file. Accessing a CHO
within an archive is done by describing its position
within the archive, instead of its ID. The reason I had to
do this was because CHO archive names are stored as ASCII
strings of max length 63 bytes. To implement ASCII names
within the DAMM parsing algorithm did not seem like a
trivial task so I instead decided to use their location
within the archive as the accessing ID for this implemen-
tation.

The mapping from location ID to CHO name is described by
the DIR command applied to CHOS. The DIR command however
had to be made more like the DDIR command because of the
possibly long CHO names. For this reason the LDIR command
does not log the DIR listing. Also, I have not written
a DDIR command for the CHOS.

The displaying commands (D & DD) appear to be working well
with CHOS on all platforms tested. One thing to note is
that access time for large archives (over 100 histograms)
begins to become noticably slower. The reason for this is
because a CHO archive does not possess an archive directory,
and DAMM searches through the archive several times every
time it accesses a histogram. One possible solution to
this problem is to create a directory of the archive when
the user executes an IN (or QF, RF, SF) or a writing command
and store the information in a global variable. This would
slow the commands by a.few seconds but would increase the
access time for large files greatly. I was not able to
implement this method for the present version.

PROBLEM AREAS



As already mentioned above there are a few problem areas in
my additions. I thought it might be worth while to note them
here.

Accessing CHOS by their location in a file and not their name is
a very bad feature and should be addressed sometime in the future.

The slow access time for large CHO archives is a problem that
might be fixed by the above mentioned solution.

CHOS have not been implemented in several DAMM commands. Some
of these are:

LDIR, DDIR, GATE, DSUM...
and perhaps more that I am not aware of. The user..~il.lexpect
all commands to work with CHOS and these commands should be
edited to incorporate CHO support in a full release version of
DAMM that supports CHOS.

TIME SCHEDULE FOR ADDITIONAL CHANGES
To add support for LDIR and DDIR I estimate about a day of
coding and another day for debugging and cross-platform testing.

For GATE and DSUM I would estimate about three or four days
which includes learning the code, making the changes and then
debugging.

To make implement a directory structure for CHOS I estimate
two or three days.

To add accessing of CHOS by name, I estimate anywhere from two
days to two tera-days.

SEE ALSO
Intro(3cho)



DCHO (1) CHO UTILITY ROUTINES
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NAME
dcho - displays CHO objects in a CHO file

SYNOPSIS
dcho filename <filename> <filename> ...

DCHO (1)

DESCRIPTION
dcho opens a CHO file and displays all the object
tags it finds. If the file does not appear to be
in CHO format then it is skipped and dcho moves
on to the next file until all of the arguments
have been tested.

FILES
dcho

SEE ALSO
Intro(3cho)

.--—.



TESTC (1) CHO UTILITY ROUTINES

NAME
testc - tests to make sure all the CHO library
structures are the correct size on your platform

SYNOPSIS
testc

DESCRIPTION
testc checks the size of the CHO structures with
the correct values and displays any discrepancies.

TESTC(l)

The program also displays the endian architecture...
r

.—.—

FILES
testc

SEE ALSO
Intro(3cho)

.—.
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madam.txt

Welcome

The

Version

to the madam environment!

Send co&ents to:
Modular
Application for pgvl@ph.msstate. edu
Data
Analysis and cj(?ph.msstate.edu
Mani.pulati,on.

rbp@nucphy5 .ph.msstate .edu
1.0 alpha

__________________________________________________________________ .—.—------------------------------------------------------------------, ----

Madam is Modular application for data analysis
on the com
mon histogram object (cho) model. It allows a
nd manipul
ate multiple cho histograms. The current UNIX
motif and

and manipulation based

user to open, display a

implementation uses the

cho libraries and can be used with SUN OS, Solaris and LINUX.
Madamwill be av

ai.labile on ALPHA, SGI and HP workstations in the future.
for madam The source

is ANSI-c and POSIX compliant.

r I I 1- 1
I

I

I CMPS - madam – FILs <-–--->1 pipes, etc 1<----->1 other

I
I

I
I

I
I

I
I

cho

I I I

I I I processes

<---–->1 shared memory 1<-–-–->1

I I
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r’
I

I
I

I UNIX/LINUX/SOLARIS
I

!-l
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madam.txt

The madam component architecture

**The madam window

The madam window (thi,swindow) is the main window in the madam environ
ment. The
menu bar at the top of the window contains items for manipulating mad
am, CHO an
d foreign histogram files. The Message bar at the bottom of the windo
w displays ..—.— ..-—-

error messages and other information to the user. The main madam win
dow provid
es a text worksheet which is both a text editor and a shell tool. Ana
lysis comp
onents may send ascii output to the window for generating summaries an
d reports.

**The worksheet

The madam worksheet provides a flexible work space for interacting wit
h madam co

mand and p
ress the enter key.

**The Common Histogram Object (CHO)

The cho provides an extended model for storing and
ram and as
sociated data in both files and memory instances.
be platfor

mponents and the UNIX shell. To execute a shell command, type the com

manipulating histog

Cho is designed to

m independent and POSIX compliant. It IS NOT GUI neutral. The cho en
courages a
n object design approach which encapsulates both object content and be
havior int
o specific sub-objects or structures. Example cho objects include:

DATA -
e

ary

PARM -
e

The actual data (channel contents) of a histogram. Th

histogram may be of arbitrary dimension, and of arbitr

format

A structure that describes characteristics of on of th

Page 2



DISP -
of

ERRS -

MARK -

REGN -

CALB -
or

PORT -
on

ARCH -

SORT -
be

COND -

ANOT -

Ct .

TEXT -
Xt .

madam.txt
linear dimensions of the histogram. (Cursor position,
plot limits, etc.)

A structure that describes the display characteristics

the histogram. (window size, position etc)

A structures which allows errors to be included in the
cho file.

A structure that allows markers to be placed on a cho
histogram. .—---

A structure that allows regions to be defined in a cho
histogram.

A structure that allows calibrations to be specified f

the cho parameters.

a structure that provides additional porting informati

to support cross platform compatibility.

A structure which is used to include many chos in a
single archive file.

A structure

sorted.

A structure
method uses

A structure

which describes how the event stream is to

which describes a condition which the sort
to sort the event stream.

which allows other cho structures to be
anotated, i.e. a text note may be attached

A structure which stores the histogram data

The madam environment provides a user
gram data.

To open a CHO data file, select the
the File

menu.

Page 3
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madam.txt
** Format filter components

Madam format filters provide a mechanism for extending madam by adding
support f

or foreign histogram file formats. Both ‘Open’ and ‘Save’ methods can
be includ

ed in the filter component Currently filters are available or under d
envelopment
for: ‘.cho’, ‘.txt’, ‘.spk’, ‘his’, ‘.spe’ and ‘mat’. To open a hi

stogram in
some other format, a madam user must first provide a madam filter com

ponent whi —..—— ..—.

ch can translate the non-CHO data into CHO format. The filter executa
ble must b
e placed in the madam.fil directory. The component name will then app
ear in the
Open and Save submenus. Format conversion components are easy to wri

te for the
madam environment. Please see the examples provided.

** Analysis components

Madam analysis components provide a mechanism for extending madam by a
dding user
provided analysis and manipulation routines. The routines are compil
ed and lin
ked to the cho (and other necessary libraries) as independent programs
and dropp

ed into the madam.CPMs directory. The component name will then appear
in the an

alysis menu submenu.

** Current status

The cho exists as a user library with methods to access most of the cu
rrent cho
implementation. The cho access methods are provided as high–speed mac
ros which
encapsulate the data and hide most of the complexity of the cho struct
ures from
the application programmer. The cho format is continually evolving un
der the co
nstraint of backward–compatibility.

The madam architecture and user interface features were originally pro
totyped an
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madam.txt
d tested in the openlook environment. We are currently porting and un
ifying the
various modules into a motif-based madam version which runs on SUN wo
rkstations
. By the end of this month, the porting will be finished.

We are currently adding the mechanism for mapping chos into shared mem
ory. This

will allow madam to interact with the scan (online) shared memory.

** Availability
.. . — ------

The cho library and the madam source and executable are available via
ftp from
Miss State at: ph.msstate.edu

** Getting started with madam

To launch the application type “madam” at the prompt. The madam window
will open
on your screen. The window has a menu bar at the top, a text area and
a message
bar at the bottom. The text area can be used like a text editor or a
shell tool
. If you type “1s” in the command window, and then press the enter key
instead o

f the return key; the “1.S”shell command will be executed. (Commands
that launc
h applications such as damm may not yet work correctly when launch fro
mf the mad
am window. )

The menu bar has 4 menus: File, Edit, View, and Options. You can use
the File m
enu to open histograms in several different formats. By using the mot
if file ch
ooser dialog to navigate into the data/hist directory, you can open, s
ample hist
ograms.

When the ok button on the file selection dialog box is selected, a his
togram wi
11 open. A madam histogram window consists of a menu bar, a drawing a
rea and a
message bar. Use the cursors ( vertical bars) and the View menu items
to manipu

Page 5



madam.txt
late the histogram view.

** Future plans

The cho architecture is very flexible and madam must be extended to su
pport othe
r cho objects including: ERRs, CALBS, ANOTS, etc. More user support n
eeds to be
added such as printing, drag-and-drop, etc. The madam needs to be te

stealcompl
etely on additional platforms: SGI, HP, etc.,

—.___ ..—.

The intent is to encourage the community to co-develop madam based on
the natura
1 cho object boundries. Developers at LBNL, ORNL, MSU(north) have all
indicated
interest in co–development.

Additional FILs and CMPS need to be added both by the developers and t
he users.

Full documentation and examples will soon be provided on the ftp site.
Welcome to the madam environment!

The Send comments to:
Modular
Application for pgvl@ph.msstate .edu
Data
Analysis and cj@ph.msstate .edu

Page 6



.> ,,,.,,.. .,.. . . I

Attachment -3 UPAK Test Results
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Damm Commands

FILE/DEW213ASSIGNMENTSYNTAX

FOR SCREENSETUPCOMMANDS

FIGI set screenconfigurationlibnuy to default Y
FIGF FILNAM Read screenconfigurationliirary fi-omFILNAM Y
FIG N Set currentscreencontlgumtion to type-N Y
DLAF MS Set FIG4elay to MS milliseconds-(defauIt=lOOO) Y
DLAD MS Set Display-delayto MS millisemnds (deEn.dt=5Ml) Y
WINID Set subsequentdispkiYSto be in window-ID(dflt=l) Y
AXONID Enable the drawingof axis for window-ID(dfl) Y
A.XOFID Disable the drawingof axis for window-ID Y
CMAP Set color map to default (“takes”afternextFIG) Y
CMAP FILNAM Set color maPfromFILNAM (“takes”afternext FIG) Y
REw Reverseall color Y
DLNS N

specs (“takes”afternextFIG)
“Set# disp-lines= N - for HELP DDIR & DSUM Y

CURT LIVE Set full-windcursorto trackmouseLIVE(default) Y
CURT X New full-windcursormnemted via mouse-clickor key Y

The CURTcommandtakeseffectonly afternextFIG Y
SSI Set screento initial- eraseall graptic windows Y

----



: ,, t

.

SCREENCONFIGUFW~ON DIAGRAIk$

1-II 2-00 3-00 4-00 5-(XI 6-CIII 7-0: 8-;;
o ml

: M 0 00
II 00

9-00 1O-CIO 11-[-] 12-[--] 13-[-1 14- [–] 15-[2D] 16-[24
II 00 [--1 [-1 [--1
II 00 [-1 r-l

EXPLANATIONOF “VARTABLESIN FILE NAMES”,
One symbol (iitegw variable)maybe incorporatedin a FILENAME
specificationas the followingexamplesillustrate

........... .... .............................. ... ........ .... ..........
SYM=3
OU FIL”SYM”.SPKNEW ,Createsand OpfH’lSFIL3.SPK

............... ... ....................................................
1=0
LOOP 3
1=1+1
IN FIL”I”.SPK ,opens (ii succession) FIL1.SPK FIL2.SPK
FIL3.SPK
.

ENDLOOP
......................................................................

..-— —
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LOOP

r

EXECUTIONANDSYMBOLDEFINITION
comxnarIds dated to LOOP execution md SYMBOL definition .............
SYM = EXPRESSION- Define symbol (SW up to 100 symh~ SUPPOti

-symbols MN OPQRS=mmti
- expression syntax is same as in CHJL
- no imbeddedblanksam allowedin expressions
- symbolsmay containup to 4 characters(5-8 ignored)

DSYM , DisPkys list of cmnfly de~ti sumbok& values,-
LOOP N , Starts LOOP (executedN-times) N=SYM or CONST,
CMD .... , Nesting SUppOti,
CMD .... ,#linesbetween1stLOOP & matchingENDL= 100,
ENDL , Defines end-of-loop.
KILL(enteredbeforeENDL) Jdlk LOOP, ..

ctrl/c abo* looP-~-Pro8r~t @

, opening of CMD-fde withii a LOOP not allow~

-. .—.—

FOR DIRECTORYDISPLAY CMDS

DIR Display Input file directorYon VDT Y

DIRN ““ Display Input fde directoryon VDT Y

DIR O Display Output file cli.nxtoryon VDT Y

DIR P Display P-fde directoryon VDT Y

DIR Q Display Q-file directoryon VDT Y

DIR R Display R-file directory on VDT Y

.DIRS Display S-fde d.hectoryon VDT Y

DIR BAN Display BAN-file directoryon VDT Y

LDIR ... Lists directorYon Lo~-file4detice Y

DDIR I@ Dk@ay/LogdirectorYof KF-ffle in more detail
WhereIO?= NOPQRS(defaultis N)

Y
and denotex

IN-FIL OU-FILP-FJL Q-FIL R-FIL S-FIL

Y
Y

SOMEGENERALDEFINITIONS
DEFINITIONSUSED IN COMMANDSYNTAX
B1 - MemoryBuffer-1
B2 - MemoryBuffer-2
ID - The ID-numberof histogramto be read
NUID- Next ID-numberto be assignedto output histo~
LO - A fti-channel-num~ (usuallyof a Gate)
HI - A last- charmel-numker(usuallyof a Gate)
FAC - A multiplication factor
MEANINGOF THE INDIVIDUALCOMMAND-~_S
I - Input or read
o -Output or write
A - Addor amunulate
s -shift (gain Shtit)
GX - Gate on X-parameter(i.e.parame= # 1)
GY - Gate on Y-parameter(i.e. parameter# 2)
1 - Buffer-1
2 - Buffer-2
M - Multiply
c -Crunch
D - Divide

..—.
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COMMANDS WHICH PULL GATES FROM 2-D HISTOGRAMS ........................

Y IDLOHI Y-JzIteto B1
Ys IDLOHI Y-gate to BI shift B1
Yo IDLOHI Y-gateto B1 outPutB1
YO IDAIDBUX31 Y-gate to B1 outputB1 (for ID=IDAIDB)
Yso IDLOHI Y-gateto B1 shift &output B1
YSOIDAIDBLOHl Y-rote to B1shift & outputB1 (forID=IDAIDB)
YA IDLOHIFAC Y-@.e to B1 B2=B2+FA@Bl
YSAIDLOHIFAC Y-gateto B1 shift B1 B2=B2+FAC*B1
X IDLOHI X-gateto B1
Xs IDLOHI X-~atetoB1 shiftB1
Xo IDLOHI X-gate to B1 outputB1

GXO LDAIDBLOHI X-gateto B1 outputB1 (for ID=IDAIDB)
GXSOIDLOHI X-gate to B1 shift & output B1
GXSOIDAIDB~HI X-gateto B1 shift & outputB1 (forID=IDAIDB)
GXA IDLOHIFAC I X-@e to B1 B2=B2+FAC*B1
GXSAIDLOHIFAC I X-gateto B1 shiftB1 B2=B2+FAC*B1

v

v

v

v

v
v

v

v

Y -.. —.—
v

v

v

Y
Y
,,

v

COMMANDSWHICH PERFORMGENERALPROJECTIONSFROM 2-D HISTOGRAMS

PJ IDBIDDEGR PROJ TO B1 n (3)
PJS IDBIDDEGR Proj toBl shift B1 n (3)
PJO IDBIDDEGR Proj to B1 output B1 n (3)
PJO IDAIDBBIDABIDBDEGR Proj toBl output Bl n (3)

(outer looP onBID inner loop on ID) n (3)
PJSOIDBIDDEGR Proj to B1 shift& outPut B1 n (3)
PJSOIDAIDBBIDABIDBDEGR- Proj shti output n (3)

(outerloop on BID inner 100Pon ID)- “ n (3)
PJA IDBIDDEGRFAC Pmj to B1 B>B2+FAC*B1 n (3)

, PJSA IDBIDDEGRFAC Proj to B1 shtit B1B2=B2+FAC*B1 n (3)
PJAL Pr@ct all bananasin currently open n (3)

BAN-filefor J31S-ffleID’s& DEGR’s n (3)
containedtherin n (3)

, 01 OutputB1 n (3)
02 OutputB2 n (3)
(DEGR= Projection-axisanglein degrees)
ID denoteshistogram-ID, BIDdenotesbanana-lD

. .. —-
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COMMANDSWHICHMANIPULATETHE INTERNALDATABUFFERS(B1 & B2) -

.MIXM Multiply B1 by XM Y
M2XM hfukiplyB2 by XM Y
Cl ICRUN CrunchB1 byICRUN(standardcrunchun;hanged) Y
C2 ICRUN CrunchB2 by ICRUN(standardcrunchUIlChi311f@’) Y

,s1’ Shift B1 by St.SIldardGASP Y
S2 Shift B2 byStlUlddGASP Y
S1 X11X12XF1XF2NCF ShiftBlasspmfi“ ed (standardGASPUIICbllj@) Y
S2 X11X12XF1XF2NCF ShiftB2assPecI“tied (standardGASPUIICkll$@) Y
Z1 Zero B1 Y
,22 ZeroB2 Y
A12 FAC B2=B2+FAC*B1 ... .—.— Y
A21 FAC B1=B1+FAC*B2 Y
SWAP Swap B1 & B2 Y
M2D1 FAC B%(FAc*B2)/Bl Y
01 OutputB1 Y
02 OutputB2 Y

COMMANDSWHICHLIST DATA ON TERMD?ALOR PRINTER

PR1 Print B1 Y
PR2 Print B2 Y

, D1 LOHI DisplayB1 (channelsLO thruHI) Y
,D2 LOHI DisplayB2 (channelsLO thruHl) Y

COMMANDSRELATEDTO PRINTER-PLOTS

SKRZ Set to skiprepeated-zerosforminter plots Y
PLRZ Set to Plotrepeated-zerosforPrinterplots Y
PLG IDLOHINCYC Input to B1 &LOG plot Y
PLN IDLOHINCFS “ Input to B1 & LIN plot Y
PLO IDAIDBLOHINCYC Input to B1 &LOG Plot (for ID=IDAIDB) Y
PLN IDAIDBLOHINCFS Input to B1 & LINplot (forID=IDAIBD) Y
PLG1LOHINCYC Log Printer-plotof B1 Y
PLG2LOHINCYC Log Printer-plotof B2 Y
PLN1 LOHIIWFS LinearPrinter-plotof B1 Y
PLN2LOHINCYC Linear Printer-plotof B2 Y

(NCFS= # of counts full-scale for LIN plots)
(NCYC= # of cycles for LOG plOtS)

..—
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COMMANDSWHICHMODIFYTIiE CHANNELCONTENTSOF INTERNALBUFFERS

I SET1 ICNYV I Set channel ICN of B1 to YV IY I
SET2 ICNYV Set channel ICN of B2 to YV Y
SET1LOHIYV Set channelsLQ-thru-HIof B1 to YV Y

. SET2LOHIYV Set channelsLO-thru-HIof B2 to YV Y
SET1LOHIYAYB SetchannelsLO-thru-HIofB1 to YA-thru-YB Y
SET2LOHIYAYB Set channelsLO-thru-HIof B2 to YA-thru-YB Y
ADD1ICNYV AddYV tochannelICNof B1 Y
ADD2ICNYV AddYV tochannelICNofB2 Y
ADD1LOHIYV AddYV to channelsLO-thru-HIof B1 Y

‘ ADD2LOI-IIW AddV/to channeIsLO-thru-HIof B2
—..—.—

Y
ADD1LOHIYAYB AddYA-thru-YBto channels LO-thru-HI ofB1 Y
ADD2LOHIYAYB AddYA-thm-YBto channels LO-lhru-HI ofB2 Y

SOME CMDS RELATED TO TESTING

GEN IDKOKXNCH Generatetest spechum in B1 (NCHchannels) Y
Channelcontents= KO+KX*(channel#+l) Y

COMP NCH CornParefirstNCH-channelsof B1 & B2 Y
@“ves# countsand# mis-matches) Y

SUM1LOHI Display sum of countsLO-thin-HIof B1 Y
SUM2LOHI Disnlav sum ofccmnLsLO-thru-HIofB2 v

.-. —-
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l-KEY CURSORCOMMANDSFOR 2-D DISPLAY

IQ IQ tit cursor-mode (return to normal-mode) IY

COMMANDSRELATEDTO PEAK-FINDINGDISPLAYLOGGING

Turnpeak-find& d~kiy ON (BIAS=5.0FWHM=5) Y
FIND BIASFWHM “ Turnpeak-find& displayONWhere Y

BIAS= peakdetect tlue.shold(usefulvalues= 3-10) Y
FWHM = approximatepeakFWHMin channels(iiteger) Y

NOFI Turn peak-find &display OFF (defaultis OFF) Y
PLON Turns @ 10~@l~ ( to damm.log)ON Y
PLOF Turnspeak logging(to damm.log)OFF (default) Y



MANUALENTRYOF PEAKBACKGROUND& SKIP-REGIONS

PZOT Zem the I%.&Library Y
PK XWASLOASHI Liit of completepeak specifications Y
BZOT Delete-FixedBackgroundarraY Y
BACK XIY1 lC2Y2.. XY-wints for fixedbackground Y
Sm Without List turns SKIP OFF Y
SKIP 1112J1J2 .. Up to 4 regions to omit from Fit Y

DEFINITIONOF FWHM ASYM WLIM ALIM NBC ECAL
,

.—

‘,FW FwmFwc Cefllcientsfor standardwidthfunction Y
ASYM ASLOASHI StandardLAIide andHi-Sideasymmetries Y
WLIM FWLOFWHI “Variationlimit factorsfor peak widths Y
ALIM FALOFAHt Variationlimit factorsfor peakasymmetries Y
NBc NBc Numberof powerseriesterms in variableBGD Y
WOOD ON/OFF Says turnWoods-Saxonbackgroundterm ON/OFF Y

ON createsan additionalbackgroundcomponent Y
with a Woods-Saxon“jog”undereachpeakwhich Y
is POrportional to the peak intensity. Y
(defaultis OFF) Y

ECAL ECOECAECB Coefficientsfor standardenergycaliition Y
Y

RELATIVEINTENSITYFIXINGCOMMANDS

RELI XR Specifies that the relative intensityof rhe Y
library peak nearest to channelX is to be R. Y
R may k. in any ‘units” (8 characterlimit!) Y
Peak-areaswill be in the sameratios as the Y
relative intensitiesspecifIedONLYif width Y
and asymmetrypararnetersare the same. Y
RELIHAS NO EFFECT UNLESSTHERE ARE20R Y
MORE
SUCH PEAKS IN THE REGIONFfITED. Y
RELI Speeificationsmust be enteredAFI’ERthe “ Y
associatedPeaklib-al-yentriesate completed . Y

RELI ZOT Says deleteall dative intensityentries Y
RELI OFF Says turn OFF (disable)relativeintensity Y

controlbut do not deletepreviouslyentered data Y
RELI ON Says turn ON (enable) relativeintensity control Y

-----
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VARTATIONCONTROLCOMMANDS

DPX XSTEPDXMAX Initial step size and limit for peak pos
DEL DELDELFACNDEL Inh.ialstep size step size mukiplier and ‘

number of DEL-valuesto use
VB Use VariableBackground(thedetlwk)
FB Use Fixed Backgroundif available .
Vx KVAR Kindofvariationforpeakpositions
VW KVAR Kind of variationforpeak widths
VALO KVAR Kind of variationforLo-Sideasymmarks
VAHI KVAR Kind of variationfor Hi-Sideasymmetries
WAR=UIND saysvaxyUnconditionallyIndependently

= CIND says vary ConditionallyIndependently
——

,
= ULoc saysvaryUnconditionallyImcked
= CLoc says vary ConditionallyLocked
=FIx SaySkeep Fixed - this the default assi~ emt ‘

GENERALFITDISPLAYCONTROL COMMANDS

WINNW SIX subsequent displays to be in window-NW

LIN/LOG set gmphic displayto LIN (default)or LOG
DMM MINMAX Set display limits (minmax counts)

MIN or MAX= X says use min or max data value
DL ILOIHI Set dwlay-ran~e (channel#hits)

DS ID DispIayspectrurn#ID (raruzedefinedby DL)
DS IDILOIHI Displayspectrurn#ID (I3Lvaluesreplaced)

(MAX value of IHI-ILO = 8191)
DSX ID DisplayDatadefinedby ExpandRetion
c Enter l-key cursor-mode

Y

Y
Y

COMMANDSRELATEDTO DISPLAY OF FITS

WINNW Set subsequentdisplaysto be in window-NW Y
MON/MOF Turnpeak-markersON/OFFfor DF (dfk4N) Y
DFI Set to display(DF) DATAFITBGD(default) Y
DPK Set to display (DF) DATAFITPEAKSBGD - Y
DPPB Set to display(DF) DATAFIT(PEAKS+BGD)BGD Y
DF Display Flt (channel-limitsgiven by Fit-range) Y
DF ILOIHI Dkplay Flt (channel-limitsgivenby ILOIHI) Y
DC NPK Dkplay Calculatedpeak # NPK+RESIDUAL Y

.. .. .,.
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FIT CONT’ROLCOMMANDS

m IDIUXEII Fit Request- (non-limxwgrad.ent search) Y
GFIT IDILOIHI Fit request- (gaussianmethod) Y
RFIT IDLLOIHI Resume FIT/GFiT start with Parms from last Fit Y
L??IT IDILOIHI I-hear Fit - no non-linear search Y

(Fit-range specified by ILOIHI) Y

FIT IDx Fit Range spec ifkd by cursors (Fit Region) Y
GFIT IDX Fit Rangespecifiedby cursors (Et Region) Y
RFTI’ IDx Fit Range specifiedby cursors (FitRegion) Y
LFIT IDX Fit Rangespecifiedby cursors (FitRegion) Y
Ctrvc TerminatesFit-in-progress Y

, . ..—.—

COMMANDSWHICH DISPLAY PEAKS BGD-POINTS& FIT-PARMS

PRP XLOXHI Displaypeaks fromLibraryinrange XLOthru XHI Y

PRP DispIayall ueaks flomLibrary Y
PRB Displayall freedbackmmnd point Y
FSTAT Displaycurrentfit-pammeters Y

COMMANDSRELATED TO LIST PRINT OR HARD-COPY

KPPL NONE Do no printerPlots(default) Y
Plot FITS only Y

ALL Plot FITS COMPONENTSand RESIDUALS Y
PR Print and Plot Rsults of last l% on printer Y
DR Liit results of last Fit on VDT (terminal) Y

COMMANDSWHICH SAVE FIT PAREMETERSIN LIBRARY

SAV IJ Save all Parms frompeaks I thru J of last Fit in PK-LIB Y
SAX IJ Save X-Parms for peaks Ithru Joflast Fit Y
SAW U Save W-Parms for peaks Ithru Joflast Fit Y
SAL IJ Save ASL-Parmsfor peaks Ithru Joflast Fit - Y
SAH IJ Save ASH-Parmsfor peaks Ithru Joflast Fit Y

(I.fl.JomrnittedindicatedPannsfiam ALLpeaksaresaved)

. . ..-



COMMANDSWHICH SET FIT PARAMETERS

SET-X1X2 Set STDWIDTHand ASYM for peaks in rangeXl-X2 Y
values (definedby FWAFWB FWC ASLOASHI) Y

SETWX1X2 Set WIDTHfor peaksin range Xl-X2 to STD vahe Y
SEIW X1X2WAWBWC Set WIDTHfor peaksin range X1-X2 to value Y

definedbyWAWBWC(FYVAFWNWc Unchanmxf) Y
SETLX1X2 Set ASLO for peaks in rawe Xl-X2 to STD value Y
SETLX1X2ASLOT Set ASLO=ASLOTforpeaks in rangeXl-X2 Y
SETHX1X2 Set ASHI for peaks in range Xl-X2 to STD value Y
SETHX1X2ASHIT Set ASHI=ASHITforpeaks in range X1-X2 Y

(IfXlX2.. omittedindicatedParms forALLpeaksareset) —,

LIST OF DEFAULTPARAMEti VALUES

DEL = 0.05 FwLo = 0.5 Vx =CIND
NBC=2 DELFAC=O.25 FwHI = 2.0

-w =CLoc WOOD= OFF NDEL=l
FALO= 0.5 VALO=FIX KPPL= NONE
XSTEP= 0.5 FAHI = 2.0 vAHI=Frx
DXMAX= 5.0 ASLO = 0.0 ASHI= 0.0

l-KEY (OR 2-KEY)1
Thesecommandsare I

Type:C
P/UP

Wluw

o/uo

B/UB
Ll%lRo
RT-ARO
r

XJRSORRELATEDCOMMANDS
did aftera DS or DSXcommand

to entercursor-mode Y
AddPeIete peak to Libmry(POSspecilied by ClES-W) Y
Move nearest displayed peak to cusor POS(AV ASYM unchanged) Y
Fix/Free peak POSition(for displayedPeaknearestto cursor) Y
Fix/Free peak width (fordisplayedpeak nearest to cursor) Y
Fiiree LcA3ideASYM (fordisplayedpeak nearestto cursor) Y
Fix/Free Hi-SideASYM (fordisplayedpeak nearestto cursor) IY
Turn peak ON/OFF (for displayedpeak nearest to cursor) Y
Add/Deletebackgmundpointat cursorposition Y
Set Expand Region Lo-Limit Y
Set ExpandRegion EIWmit Y
Set Fit Region Lo-Limit Y
Set Fit Region Hi-Limit Y
Displaychan#cursorY-valuethan contents Y
Disp sum cent& fwhmof Fit-Reg- DAT(~DATO)definesBGD Y
Disp sum cent& fwhm of Fit-Reg- CUR(oCUR(l) definesBGD Y
Return from cursorcontrolroutine Y
Expanddisplay(regiondefinedby<- ->) Y

-----
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HISTOGRAMXFERCOMMANDS

HOU FILNAM Open FILNAMfor histogramoutput Y
GSX Him XF1XF2 Define X-gain-shfi Y
GSY Y11Y12YF1YF2 Define Y-gain-shfi Y
GSXOF/GSYOF . Turn OFF X/Y-gain-shift Y
SNEG OFF Turn OFF resetof neg 16W out data (default n (1)
SNEGIV Says set negative M-bit output data to IV n(1)

(YouMUST use SIDA mode for this to work!!) Y
HSTA Shows fdes open& gain-shift&ta Y
HCOPIDIIDO-@b CoPyI?TDI (Input) to IDO (Output) Y
HADDIDIIDO@IxFO> Add1 Y
HDIVIDIIDOe

~vmx “w’” m
by IDO&savein IDO Y

. SHIFIDIIDO @in-shift IDI & StOmin ~ Y
SHADIDITDO<FIxFO> Gain-shiftIDI & add to IDO Y
HSETIDOIV Set IDO on Output file to IV Y
HZOTDO Set IDO on Output fde to O - Y

SPK-SUMSHIS-SUMSAND DIRE~RY COMMANDS

DDIR KF Dmlaydirectoryof KF-fde Y
Where KF = NOPQRS(defaultis.N)and denotes: Y
IN-FIL OU-FILP-FIL Q-FILR-FE S-FIL Y

DSUM I@ Displays count-sumof all histograms in KF-file Y
WhereKF has samemeaningas above Y

COMMANDSDEFININGMOUSE-BUTTONS(WHENIN l-KEY CURSOR-MODE)

BUD LMR DefinesLeftMiddIeRiEhtbuttons for cursorin D-window Y
BUDDLMR DefinesLeftMiddIeRiEhtbuttons for cursorin DD-window Y
BUDSLMR definesLeftMiddleRightbuttons for cursorin DS-window Y
BUD LHS Example (cursorin l-D) L-butt sets sum-reglo-limit Y

M-butt sets sum-reghi-Iimit R-butt reqUestss-sum Y
BUDDA’IZ ExamPIe(cm in 2-D) L-butt adds bananapoints Y

M-butt totalizesenclosedcounts R-butt zots banw Y

1: COMMANDNOT RECOGNIZED.

3: READ ERROR ID NOT FOUND.
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CHAPTER VI

SUMMARY AND CONCLUSIONS

The RelativisticNuclear Hydrodynamic Code ( RNHC-) has been developed. A ----

simulationof the collisionof nuclei in the relativistic limit can be obtained by using this user-

fiiendly code. The KNHC includes the tectilques for constructing an adaptive grid. In this

research the relativistic nucle~ hydrodynamics equations were solved in curvilinear

coordinate system.

The adaptive grid as seen in figures 16 through 19, moves with the solution and

concentrates in the region of high density. Hence in the region of high density the grid size

drasticallydecreases. As the error in the nu~erical simulation is proportional to the grid size,

it is clear that we get a better Wlution in the region of high density. Many researchers in the

area of grid adaptation have indicated that when adapted appropriately, most numerical

solutions can be improved [26].

Comparing figures 14 and 15, it is clear that sharper shocks can be seen by using

an adaptive grid. Many researchers have made efforts to reduce enors associated with

numerical approximation of nuclear hydrodynamic equations, by increasing the number of

finite differencecellsper dimension.In t@ approach there were constraints of computer time

and memory. Some researchers suggested the idea of introducing the adaptive grids in

multidimension to overcome such problems. This idea was successfully implemented in this

87
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multidmension to overcome such problems. This idea was successfidly implemented in this

research.It overcomes the constraintsof computer time and memory.
,-

Comparing plots of three-dimensionalsimulationobtained usitigthe SE@STA

and the basis-splineschemes, as seen in figure 27, with the plot obtained using the relativistic

HLLE scheme as seen in figure 26, it can be said that the results are comparable. The peak
—.—

in the maximum energy densi~- distribution occurs at 1 fide, and the corresponding eneraW

in all three simulationswas about 60 (3eV/fin3. Although the results are comparable for all

three schemes, there were substantial differences in computer time needed to execute the

schemes. The total time taken for one simulation by using the basis-spline was 3.5 hours on

a 32 node machine. SHASTA calculations were completed in 2 hours on an IBM machine.

The total time required for one simulationby Using the RNFIC code on Sun Workstation was

only 17 minutes. {’\

When a uniform grid with grid spacing of 0.2 was adapted, the ~gridnarrowed

down to 0.11. Thus the accuracy of fine grid spacing Was achieved in the region of interest,

without adding more ~gid points. An attempt was made to produce a simulation on the

uniilorm grid with a spacing of 0.1, to compare with the results obtained by using the adaptive

grid. ~ seen in figure 29, the scheme wtis not stable for that small grid spacing as the CFL

(At/Ax) is high (about 0.7). ~: . .. ~

Figure 38 shows the maximum density distribution as a fi.mctionof time using

@orrn grid of grid spacing d.x= 0.2 and dx = 0.15. In order to obtain a smaller grid spacing,

the numberofgrid pointswere increased.The tot~ CPU time taken for one simulationon an

ufiorm grid with grid spacing 0.2 was about 17 minutes,where total CPU time for one
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simulation on fine grid of grid spacing 0.15 was 23 minutes. Figure 39 shows the maximum

energy distribution as a function of time using a uniform grid and an adaptive grid with grid

spacing dx = 0.2. The total CPU time for adaptive ~tid simulation was about 19 minutes,

where grid was adapted 11 times. Comparing figures 38 and 39, it is clear that adaptive grid

res@s are more comparable to those on uniform grid with smaller grid spacing. This shows
—

a clear advantage of grid adaptation.

In conclusio~ since experimental results of heavy ion collisions in the ultra-

relativistic limit are still not available, the need for the numerical simulation of the collision

arises. Thus, the numerical simulation should be as accurate as possible, in order to have

predktions for fiture experimental results. One way of obtaining most accurate results is to

have very high resolution ( total number of grid points ) in the domain where the

hydrodynamic equations we solved. Th~ other way is to adapt the ~g-id,such that the high

resolution is obtained where the density is higher, without adding more grid points. This

second approach does not have any constraints of computer time and memory. Thus the

simulation obtained, by using the grid adaptation provides a strong base for predicting the

experimental results.

.,
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sum w And Conclusion

The one dimensional tests shown in chapter V, showed that the problem of nuclear

hydrodynamics requires a stable method for a high left.bight ratio along th~ two sides of

the discontinuity in the initial conditions. In the case of nuclear hydrodynamics tests, a

ratio of zero to one in density and pressure exist along left and right sides of the problem

(see figure 5.1). However, to make the problem controllable a value of 10-5has been used

instead of zero. The second order HLLB passed all the one dimensional test cases which

were considered for this study. The implicit two pass scheme failed one of the test cases

because the problem is not linearizable. In order to use an implicit method to solve the

problem of nuclear hydrodynamics,

scheme does not depend on equation

solution of a non-linear system

a non-linearized implicit scheme is required (a

A43). Such an implicit scheme would require the

of }equations which make it very expensive

computationally. For this reason the implicit schemes were not used in this study.

The second order HLLE which has passed all the one-dimensional tests was

extended to three dimensions and was used in the simulation of high-energy heavy-ion

collisions. Two examples which were used in this study were the collision of Uranium

138 with Silicon 28 and the collision of Gold 180 with Gold 180. These two collisions

were considered because they are going to be of the first experiments in the high-energy

heavy-ion collider at Brookhaven National Laboratory. The code developed for this study

can be used to simulate any high-energy heavy-ion collision. Furthermore, the code can

be expanded for use with any relativistic hydrodynamics problem.
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Two versions of the nuclear hydrodynamicscode were developed. The fust one

uses a Cartesianstatic grid. The seconduses a generalizedgrid with adaption. The code

can be modified to run on parallel computers if needed, because the main part of the code

consistsof six independentmajor routines(see chapterIV andAppendixB).

Adaptivegridingfor the nuclearhydrodynamicproblemhas been provento be very

useful. With very simple hydrodynamicsassumptions,we were able to obtain very

important physics results including shock formation, collective flow, and transverse flow.

By solving the continuity and conservation equations (Euler equations) in three

dimensions,-we were able to obtain results that can’be very useful and less expensive

than using a microscopic model like the boson model, single particle model or monte

carlo methods. The solution with the generalized adaptive grid is shown to be

computationallyless expensivethanobtai~ingthe samesolutionusing a Cartesiangrid.
,

The simulationwas comparedwith other methods[43, 11] and appearedto agree

withthem. The CPU time cost was less thanotherwithmethods[41].

Further study of the nuclear hydrodynamics problem will include the study of the

effect of the nuclear equation of state on the simulation of the problem and the addition of

a viscous term to the equations of relativistic nuclear hydrodynamics. Furthermore, the

study of the chemical break down of nuclear matter and the ejection of particles is also an

important addition to the results.
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CHAPTERVI

A MODULAR APPLICATION FOR DATA

ANALYSIS AND MANIPULATION

(Madam)

Introduction

A major reason for the rapid advancement of nuclear structure physics

has been due to the advances in computer technology. Faster machines and

larger capacity data storage devices have enabled larger data set to be collected

and analyzed. This is particularly true for the Gamrnasphere detector array

“described in this dissertation. Recall that there are 880 detectors involving

over 1200 data parameters in Gammasphere, and that for a typical four day

experiment, with data tape drives running at =00 kb/s, a total of 30 to 40 5.2

Gb tapes will be, required?* Due to the large amount of data parameters and

the vast amount of data that is gathered by the detector array, the

Gammasphere steering committee recognized that while development of the

hardware components of the detector array was no small task, software

k.-.:
,>.-,.-J..

--., !..g
-, ;%.-< development lies on a path that is critical to the completion of the project.m

-.,, --+‘..’<..
.:. “’;23., :<@f In order to address a broader set of interests within the user community.. -J-:,l:,’;;=?

operation, data

“
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acquisition and/or data analysis and to interact with the Gammasphere

computer facilities”, the Garnmasphere Director appointed a Software Working

Group (SWG).a

The SWG was miccessful in seeding several ideas in the nuclear

community including the idea to develop a Common Histogram Object (CHO)

that defines a file format based on an object oriented programmingg model.

The CHO provides an extended model for storing and manipulating histogram

and associated data in both files and memory instances.= Object oriented

programming is a style of programming that uses objects as the basic building

bIocks of a program. When object oriented programming techniques are used,

a program is divided into components that contain both data and procedures.

Each component is considered an object and functions like a miniature

program.”

CHO was designed to be platform independent and GUI neutral.

Although CHO encourages an object design approach, to encapsulate both

object content and behavior into specific sub-objects or structures, it is not fully

object oriented. This deasion was made in order to accommodate traditional

C programmers. In addition, CHO was designed with the following

guidelines; usability, portability, flexibility, and extensibility.

Usability is achieved through the CHO specification by providing

support of a graphical user interface (GUI) and a workspace concept. The

speafication was designed to be simple to use and maybe partially or fully
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implemented depending on the users needs. The CHO format was also

designed to

information

be machine portable which means that CHO data formatting

must be readable with many different machine types. To support

this requirement the CHO record types are self identifying and data fields are

32 bit word aligned. Bit level representations are also discouraged.

Flexibility is provided by allowing CHO to be implemented in varying

degrees. It may serve only as an intermediate porting form when data is to be

moved from one system to another or it may be implemented to fully support

file storage, GUIs, work space preservation, data analysis, etc. CHO also

provides for histogrammin gin arbitrary dimensions, the definition of regions

and conditions, for event-by+went sorting, etc.

Extensibility is provided by allowing additional record types to be

defined, the CHO can be extended to support custom applications or new data

types. Sample CHO objects that currently describe the file format are included

in Table 6.1. For a complete discussion of the CHO file format the reader is

encouraged to see reference 85.

To provide the nuclear community with a progra mming example which

interacts with the CHO

Manipulation (Madam)

model, allows a user to

library a Modular Application for Data Analysis and

was developed. Madam, which is based on the CHO

open, display and manipulate multiple CHO objects.

The current UNIX implementation uses the Motif, Xt, X, and CHO libraries

and has been tested under the SUN OS, Solaris and Linux operating systems.
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Table 6.1 A listing of available CHO objects. ‘

Object Description

DATA The actual data (channel contents) of a histogram. The histogram
may be of arbitrary dimension, and of arbitrary format.

PARM A structure that describes characteristics of the linear dimensions
of the histogram. (Cursor position, plot limits, etc.)

DISP A structure that describes the display characteristics of the
histogram. (Window size, position, etc.)

ERRS A structure that allows errors to be included in the CHO file.

MARK A structure that allows markers to be placed on a CHO
histogram.

REGN A structure that allows regions to be defined in a CHO
histogram.

CALB A strutie that allows calibrations to be specified for the CHO
parameters.

PORT A structure that provides additional porting information to
support cross platform compatibility.

ARCH A structure which is used to include many CHOS in a single
archive file.

SORT A structure which describes how the event stream is to be sorted.

COND A structure which descriies a condition which the sort method
uses to sort the event stream.

ANOT A structure which allows other CHO structures to be annotated,
i.e. a text note maybe attached to any-object.

E.X-r A structure which stores the histogram data as ASCII text.

.
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Madam will be available on ALPHA, SGI and HP workstations in the future.

The source for Madam is written in ANSI-C.

The rest of this chapt& will describe the Madam application relationship

with user input and interprocess communication followed by an introduction

to Madam’s analysis and filter components. Then there will be a short “

discussion of current status, future plans, and availability of Madam.

Appendix B of this dissertation contains a short tutorial on Madam including a

detailed discussion of Madam objects. Appendix C is a developers guide.

Appendix D contains a description of mnemonic and accelerator keys.

~emonics are key sequences that maybe typed to activate menus.)

Appendices E and F contain sample filter and analysis components,

respectively, while Appendix G shows a sample Madarn resource file.

The Madarn Adication

The Madam application runs on top of the operating system of the host

computer. Users of Madam can write components which can manipulate data

and communicate with the operating system through Madam. The

components are stand alone pieces of code which communicate to Madam

through a message passing scheme. Much thought was given to which

message passing scheme should be used in this application to handle the

interprocess communication (Il?C). Three types of II?C were tested for Madam

they include; pipes, sockets, and tooltalk A pipe is a one-way communication

port where one process is designated as a sender and the other process is



designated as a receiver.

pipe must be established
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If two-way communication is desired then a second

which directs communication opposite of the first.

Sockets are created in pairs and allow for two-way communication. Tooltalk is

an IPC manager from which the processes can send and receive messages.

The type of IPC chosen for an application should depend upon the number

processes involved, and the type of application for which the processes are

running. For simple, one-way data transmission among a small number of

of

processes, pipes are desired for their simplicity. For two-way communication

among a small number of processes the simplicity of using sockets over

tooltalk is probably preferable. However, for two-way communication among

a large number of processes, tooltalk’s powerful message distributing

capabilities can be fully realized. For Madam’s purposes it was decided that

pipes should be used to handle interprocess communication because of their

simplicity and the relatively small number of processes that Madam will

communicate with.

Madam allows for user input in various ways; for example the user may

pass information to Madam when the “application is launched through

command line arguments and through a resource file. However, the primary

way user input will be communicated to Madam will be through the main

Madam window. Appendix B describes the current implementation of the

main window in detail. The main window allows the users to pass shell

commands, such as “W.’,to the shell us~g the worksheet area that is built into
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the main window. (Via two-way pipes.) User input can also be provided

through the extensive GUI menu system. An important feature of the menu

system is that Madam dynamically builds menus specifying user supplied

“plug-in” modules or components. The current implementation of Madam

defines two types of components; format filter components, and analysis

components.

Format Filter Components

Madam format filters provide a mechanism for extending Madam by

adding support for foreign histogram file formats. Both ‘Open’ and ‘Save’

methods can be included in the filter component. Currently five filters are

available or under development for many commonly used formats

, .txt’, ‘.spk’, ‘his’, ‘.spe’ and ‘mat’ fik+ - To open a histogram in ..includirqy’.cho’ ‘

a format other then CHO, a Madam user must first provide a Madam filter

component which can translate the non-CHO data into the CHO format. To be

seen by Madam, the filter executable must be placed in a directory specified in

the Madam resource file. (See Appendix G for a sample resource file.) The
: .:.7 ll=y.

., ...;

~+~ filter’s executable name will then appear ih the “Open” and “Save as”
-,..:.,,.i%;,,.,,,,.<,... +.,,,.,..$4......::,,:,>Z+;$:
:‘‘-;.;~~~:submenus.#

k
-=..<:.>:,:.:T%.%-@$- .“~.;+>-s.

s , ,““?”:$.:+G”,,,..,.,.:,<,
r ‘“

~:,:a’}.;:;:,. When any of the filter menu items are selected, a file selection dialog...,-,-.,,V...~$,, ...‘.,..,.a%.{.-J. :’,7,,*.,~f.. ..,’.+$=.y&“-:- %Y= box. will open on the screen as can be seen in Figure 6.1. The file selection
q’ ; ‘.:i.$g~.

[

..&..;,’&.<?;-+’L*..4, “.-;“*i[-.diaIog box filter area will be set to “*”which will list any file in the current!. :.i”::.y<+>f.--.-.,:>,,; ‘:.-,:.’..::=,>.<2.;,.
.:, ~ :j:. $,:.:%?:.

- ,- ,,;j,..;;:,
,. working directo~. The first button in this dialog box will be labeled the same,-. ,.~.+g=~
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as the file menu item t-hatwas chosen to open the dialog. When that button is

selected Madam (via the popen command) will fork a child process and allow

the child process (filter component) to communicate with the parent process

(Madam) through a pipe.

Each filter component should include support for a main function with

error checking on usage, a method switch, a filter routine, messages, and exit.

This is illustrated in Figure 6.2 using a flow diagram. (See Appendix E for a

sample filter component.) A user can develop a new filter simply by copying

one of the example filters and changing the filter routine and some message

statements.

Communication between the filter component and Madam is handled

with standard C prinij statements. The prin~ statements send information to

the standard output which was redirected to the pipes. The valid message

strings that Madam can understand should begin with the following text

“!#!wksh_messS’, “!#!done_mess”, “!#!err_mess”, and “!#!open_mess:”. For

example, to pMt a message from the filter component into Madam’s main

window the following print statement should be put into the filter code and

compiled: prinff(“!#!zddz_nzess:message“);.Where message isthe desired text

that the user wants displayed in the mainwindow. The “!#!done_mess” text

string tells Madam that the component is finished and to send the message to
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the MadamWind foot& message area. The “!#!err_messt’ text string teIls

Madam that an error has occurred. Madam currently sends error messages to

the mainwindow’s footer m&sage area.

Analvsis Components

‘Madam analysis components provide an additional mechanism for the

user to extend Madam. By adding analysis component routines the user can

easily manipulate the histogram data. The analysis components are compiled

and linked with the CHO Iibrary as independent programs and dropped into a

directory specified in the Madarn resource file. (See appendix G for more

information about the Madam resource file.) It should be noted that other

liiraries, such as the math library, may have to be linked with the components

at compile time depending on the components functionality. The component

name will then appear in the histogram ivindow’s “Analysis” submenu.

When any of the analysis menu items are selected a file selection dialog

box will open on the screen A file selection dialog box maybe seen in Figure

6.1. The file selection dialog box filter area will be set to “*”which will list any

file in the current working directory. The first button in this dialog box will be

labeled the same as the file menu item that was chosen to open the dialog.

When that button is selected Madam (via the popen command) wilI fork a child

process and allo-wthe child process (analysis component) to communicate with

the parent process (Madam) via a pipe.
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Each analysis component should include support for a main function

with error checking on usage, possible creation of an output CHO, the analysis

routine, possible save if a new CHO was created, possible other analysis

routine, messages, and then exit. This is illustrated in Figure 6.2 using a flow

diagram. (See Appendix F for a sample analysis component.) A user can

develop a new analysis component simply by copying one of the example

analysis component and changing the analysis routine and message statements.

As with the filter components the valid message strings that Madam can

understand should begin with the following text “!#!wksh_mess:”,

“!#!done_mess ,“ “!#!err_messt’, and “!#!open_mess”. For example, to open a

histogram object with the manipulated data, a message sent from the analysis

component would look like printjl “!#!open_mess:cho_file_name“);.

current status

The CHO exists as a user library with methods to access most of the

current CHO implementation. The CHO access methods are provided as

high-speed macros which encapsulate the data and hide most of the

complexity of the CHO structures from the application programmer. The

CHO format is continually evolving under the constraint of

backward-compatibility. The Madam architecture and user interface features

were originally prototype and tested in the OpenLook environment. Madarn

has been ported to Motif and runs on SW workstations under SUN OS and

IBM C~OIWS running the”Linux operating system.
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Figure 6.3 A flow diagram for a Madam analysis component.
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Future Plans

The CI-10 architecture is very flexible and Madam should be extended

to support oth& CHO objects including ERRS, CALB, ANOT, etc.

Community wide user support is needed to add options such as printing, and

drag-and-drop. The Madam application also needs to be tested thoroughly on

additional platforms such as SGI, HP, etc. The intent is to encourage the

community to c~evelop Madam based on the natural CHO object

boundaries. Developers at Lawrence Berkeley National Laboratory, Oak Ridge

National Laboratory, and Michigan State University have all indicated interest

in co-development. Additional filter and analysis components need to be

added both by the developers and the users of the application.

Availability

The CHO l.ibr@ and the Madam source and executable are available

via anonymous ftp from Mississippi State University ati ph.msstate.edu and

also via the world wide web at http/ /ph.msstate.edu.

Conclusion

.A Modular Application for Data Analysis and Manipulation (Madam)

has been developed to provide the nuclear community with a programming

example which interacts with the CHO Mmry. Madam is written in ANSI-C

utilizing the X, Xt, and Motif toolkit while remaining standard compliant.
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The Madam application defines three types of objects, the MadamWind,

the HistWind, and the PanelWind. The MadamWind object provides a

worksheet, shell like window and is the main controlling window of the

application. The HistWind object provides the user with a means of viewing

and

this

manipulating histogram data. The PanelWind object was not discussed in

dissertation but has been designed to build control panels to control

Madam.

Madam allows the user to extend the application by providing two

types of components that plug into the application filter components and

analysis components. Filter components allow the user to read or write

foreign file types into and out of the Madam application while analysis

components allow users to manipulate histogram data with their own

customized analysis routines or with standard supplied routines.

Future plans for Madam include development of three dimension

drawing routines once they are fully supported by the CHO Iibrary. Madam

must also be extended to support other CHO objects including ERRS, CALB,

ANOT, etC.
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CONCLUSION

The nucleus is a quantum

Introduction

mechanical system. The properties of the

nucleus vary from system to system depending on the numbers and types of

nucleons in the system. One way that nuclear physicists are able to better

understand the nucIeus is by studying y-ray emission. y-ray spectroscopy is

the study of y radiations between energy levels in a nucleus. y-ray

spectroscopy techniques were used to probe three nuclet 181Hg,l=Au, and

l@Pt. Also

which was

data.

presented is an introduction of the soitware application, Madam,

developed to store, display, analyze, and manipulate histogram

Nuclear Sh-ucture of ~slHg

The main reasons 181Hgwas studied were to place y rays into the level

scheme that were too weak to place from the pre~ous experiment, search for a

poss&le signature partner rotational bands built on the 7/2– [514] particle

configuration, measure directional correlations, DCO ratios, and to study

properties of the lighter mass Hg isotopes. In order to study these properties,

.
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an experiment was developed to populate high spin rotational levels of 18*Hg.

The compound nuclear reaction

at a beam energy of 180 MeV and with a 8.155 mg/cm2 l%m target foil was

used to populate 181Hgvia the 3n evaporation channel. The experiment was

conducted at the Argonne National LaboratoW using the Argonne-Notre Dame

BGO Gamma-Ray Fa&y. A multiplicity filter of two CSS and two BGO

detectors was used to obtain y-y coincidence data which was recorded to

and brought back to MSU for analyses.

The major result of this study was the identification

signature partner rotational bands which were also seen in

Five intra-band y-ray transitions were placed in each band

tape

of the 7/2– [514]

lSHg and lSHg.

with the highest

spin reaching 29/2—ii. five inter-band transition were also placed into the level
...~, /h;@’

,,.,- .,.+
,,&

: ‘..<;.;3.?< scheme comecting the two bands together. Other results of this study include~~.,,:<,!,
.’~”x;.L*?,’.>,<+~~~.’. the firm placement of a 80.5 keV y-ray transition in the ground state band and!‘...;,?$.,,..,.,

DCO ratios for 8 transitions. Relative intensity

also obtained for all of the y-ray transitions placed into

Nuclear Structure of lUAU
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therefore, product nuclei, 182Hg in this case, came to rest after recoiling a short

distance within the target. The ground state of laHg has a half-life of

approximately 11 seconds and decays primarily through electron capture. The

electron capture of l=Hg results in the population of excited states in l=Au. y-

ray energies, relative intensities, and coincidence relationships were

determined allowhig development of a level scheme containing 15 y-ray

transitions.

Nuclear Structure of *=Pt

In heavy-ion reactions, off-center collisions between the incident beam

nuclei and the target nuclei can impart a large amount of angular momentum

into product nuclei. Some nuclei may spin with an angular momentum of

greater then 60%. Nuclei that spin with a high angular momentum, such as

those produced in heavy-ion reactions, can have a large moment of inertia, Y.

The large @allows states with the 2 to 1 axis ratio to be lowered below

spherical or normally deformed states. This phenomena, known as

superdeforrnation, also provides the opportunity to study the interaction of

protons and neutrons under the extreme condition of very high angular

momentum. This leads to the main reasons for studying *aPt, a search for

superdeformation. A secondary reason was to measure of the alignment

pattern of the il~/2protons which might reveal a strong residual n-p interaction

with the single rotationally aligned ~~,zneutron. Furthermore, an

improvement of the conventional level scheme was desired.
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As a r&ult of this study four, possible six, new rotational bands have

been discovered containing over 50 new y-ray transitions. Both y-ray energies

and intensities were measured. Superdeformation was sought within the data

set but not found.

Madam

A major reason for the rapid advancement of nu&ar structure physics

has been the advances in computer technology. Faster machines and larger

capacity data storage devices have enabled larger data sets to be collected and

amlyzed and has given rise to a need for improved computer software. One

such software package, Madam, sits atop the operating system, interacting

with and manipulating CHO based objects via CHO library calls. Madam

.defines methods in which users may develop “plug-in” component modules

that manipulate histograms. Prototypes for two types of modules have been

defined; one is a filter component and the other is an analysis component.

Filter components allow users to introduce foreign file types into the Madam

application while analysis components alIow the user to design personal

analysis routines such as background subtraction and peak fitting.
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This appendix shows a partiaI listing of the file “sdl.lis” The file contains
results from a superdeformation search. If the searching routine found a
superdeformed band the Merit value would be close to one.

Liit a, El= 400.0 120 3-gates, Mean cnts = -6.9+/- 25.4 55.7, Merit =-0.12
List a, El= 402.0 120 3-gates, Mean cnts = -22.8+/- 27.1 77.3, Merit =-0.30
List a, El= 404.0 120 3-gates, Mean cnts = -11.7+/- 20.3 41.3; Merit =-0.28
List a, El= 406.0 120 3-gates, Mean cnts = -112+/- 18.2 47.5, Merit =0.24
Liit a, El= 408.0 120 3-gates, Mean cnts = -15.0+/- 21.9 48.5, Merit =0.31
List a, El= 410.0 120 3-gates, Mean cnts = -1.2+/- 18.3 26.5, Merit =-0.05
List a, El= 412.0 120 3-gates, Mean cnts = -1.9+/- 15.8 22.8, Merit =-0.08
List a, El= 414.0 120 3-gates, Mean cnts = -6.2+/- 21.7 48.4, Merit =-0.13
List a, El= 416.0 120 3-gates, Mean cnts = -7.8+/- 23.5 66.0, Merit =-0.12
List a, El= 418.0 120 3-gates, Mean cnts = 1.0+/- 16.4 19.9, Merit = 0.05
List a, El= 420.0 120 3-gates, Mean cnts = 3.6+/- 15.8 22.7, Merit = 0.16
List a, El= 422.0 120 3-gates, Mean cnts = 2S+/- 16.1 22.3, Merit = 0.09
List a, El= 424.0 120 3-gates, Mean cnts = -0.7+/- 19.6 68.3, Merit =-0.01
List a, El= 426.0 120 3-gates, Mean cnts = 4.3+/- 21.0 45.7, Merit = 0.09
List “a,El= 428.0 120 3-gates, Mean cnts = 3.1+/- 19.6 27.9, Merit = 0.11
List a, El= 430.0 120 3-gates, Mean cnts = -0.9+/- 24.1 49.4, Merit =-0.02
List b, El= 550.0 120 3-gates, Mean cnts = 6.0+/- 11.8 23.5, Merit = 0.26
List b, El= 5520 120 3-gates, Mean cnts = -1.0+/- 14.8 19.3, Merit =0.05
List b, El= 554.0 120 3-gates, Mean cnts = -1.9+/- 15.2 24.3, Merit =-0.08
List b, El= 556.0 120 3-gates, Mean cnts = 0.1+/- 10.0 11.9, Merit = 0.01
List b, El= 558.0 120 3-gates, Mean cnts = -1.1+/- 15.5 16.1, Merit =-0.07
List b, El= 560.0 120 3-gates, Mean cnts = -2.2+/- 16.0 20.5, Merit =-0.11
List b, El= 5620 120 3-gates, Mean cnts = -0.3+/- 10.0 11.0, Merit =-0.03
List b, El= 564.0 120 3-gates, Mean cnts = 23+/- 15.8 18.6, Merit = 0.12
List b, El= 566.0 120 3-gates, Mean cnts = 4.4+/- 17.8 34.5, Merit = 0.13
List b, El= 568.0 120 3-gates, Mean cnts = 0.7+/- 10.2 13.4, Merit = 0.05
Liit b, El= 570.0 120 3-gates, Mean cnts = -0.4+/- 13.4 13.8, Merit =-0.03
List b, El= 572.0 120 3-gates, Mean cnts = 0.7+/- 13.0 14.1, Merit = 0.05
List b, El= 574.0 120 3-gates, Mean cnts = -0.1+/- 8.2 8.7, Merit =-0.01
List b, El= 576.0 120 3-gates, Mean cnts = -0.7+./- 14.4 19.5, Merit =-0.04
L~t b, El= 578.0 120 3-gates, Mean cnts = -2.6+/- 15.3 20.5, Merit =-0.13
List b, El= 580.0 120 3-gates, Mean cnts = 1.4+/- 8.8 10.3, Merit = 0.13
List c, El= 700.0 120 3-gates, Mean cnts = 1.1+/- 4.9 7.9, Merit= 0.14
List c, El= 702.0 120 3-gates, Mean cnts = 0.6+/- 8.9 10.1, Merit = 0.06
List c, El= 704.0 120 3-gates, Mean cnts = 0.7+/- 8.6 9.0, Merit = 0.08
List c, El= 706.0 120 3-gates, Meart cnts = 0.8+/- 4.4 4.8, Merit = 0.17
List c, El= 708.0 120 3-gates, Mean cnts = 1.7+/- 8.3 8.0, Merit = 0.21
List c, El= 710.0 120 3-gates, Mean cnts = 1.2+/- 8.2 8.3, Merit = 0.14
List c, El= 712.O 120 3-gates, Mean cnts = 0.9+/- 4.3 4.1, Merit = 0.21
List c, El= 714.0 120 3-gates, Mean cnts = 1.1+/- 8.4 8.0, Merit = 0.13



I&t c, El= 716.O 120 3-gates, Mean cnts = l.7+/-
List c, El= 718.O 120 3-gates, Mean cnts = 0.5+/-
List c, El= 720.0 120 3-gates, Mean cnts = 0.4+/-
List c, El= 7220 120 3-gates, Mean cnts = 0.9+/-
List c, El= 724.0 120 3-gates, Mean cnts = 0.5+/-
List c, El= 726.0 120 3-gates, Mean cnts = l.3+/-
List c, El= 728.0 120 3-gates, Mean cnts = l.O+/-
List c, El= 730.0 120 3-gates, Mean cnts = l.2+/-
List d, El= 850.0 120 3-gates, Mean cnts = 0.6+/-
List d, El= 852.0 120 3-gates, Mean cnts = l.7+/-
Lkt d, El= 854.0 120 3-gates, Mean cnts = l.4+/-
List d, El= 856.0 120 3-gates, Mean cnts = 0.6+/-
List d, El= 858.0 120 3-gates, Mean cnts = l.O+/-
List d, El= 860.0 120 3-gates, Mean cnts = l.O+/-
List d, El= 8620 120 3-gates, Mean cnts = 0.8+/-
List d, El= 864.0 120 3-gates, Mean cnts = l.l+/-
List d, El= 866.0 120 3-gates, Mean cnts = 0.7+/-
List d, El= 868.0 120 3-gates, Mean cnts = 0.8+/-
List d, El= 870.0 120 3-gates, Mean cnts = l.3+/-
List d, El= 8720 120 3-ga@s, Mean cnts = 0.6+/-
List d, El= 874.0 120 3-gates, Mean cnts = 0.3+/-
List d, El= 876.0 120 3-gates, Mean cnts = l.2+/-
List d, El= 878.0 120 3-gates, Mean cnts = l.3+/-
List d, El= 880.0 120 3-gates, Mean cnts = 0.2+/-
List e, El= 1000.0 120 3-gates, Mean cnts = O.l+/-
List e, El= 10020 120 3-gates, Mean cnts = 0.3+/-
list e, El= 1004.0 120 3-gates, Mean cnts = 0.3+/-
List e, El= 1006.0 120 3-gates, Mean cnts = 0.2+/-
List e, El= 1008.0 120 3-gates, Mean cnts = O.l+/-
List e, El= 1010,0 120 3-gates, Mean cnts = 0.3+/-
List e, El= 10120 120 3-gates, Mean cnts = O.l+/-
List e, El= 1014.0 120 3-gates, Mean cnts = O.l+/-
List e, El= 1016.0 120 3-gates, Mean cnts = 0.3+/-
List e, El= 1018.0 120 3-gates, Mean cnts = O.l+/-
List e, El= 1020.0 120 3-gates, Mean cnts = O.l+/-
List e, El= 10220 120 3-gates, Mean cnts = O.l+/-
List e, El= 1024.0 120 3-gates, Mean cnts = O.l.+/-
List e, El= 1026.0 120 3-gates, Mean cnts = O.l+/-

8.6 10.7, Merit = 0.16
4.3 4.5, Merit = 0.10
7.8 7.0, Merit = 0.06
7.7 6.9, Merit = 0.13
4.1 4.1, Merit = 0.12
7.9 8.1, Merit = 0.16
8.1 8.4, Merit = 0.12
4.4 7.6, Merit = 0.16
.27 27, Merit = 0.22
4.7 4.6, Merit = 0.36
4.6 4.4, Merit = 0.31
25 25, Merit = 0.22
4.3 4.0, Merit = 0.26
4.3 4.4, Merit = 0.23
2.4 2.5, Merit = 0.32
4.1 4.0, Merit = 0.28
4.1 4.2, Merit = 0.17
23 2.6, Merit = 0.29
4.0 4.3, Merit = 0.29
3.9 4.4, Merit = 0.14
23 25, Merit= 0.13
4.0 3.9, Merit = 0.32
4.0 3.9, Merit = 0.34
23 24, Merit = 0.10
0.5 0.9, Merit = 0.09
0.8 1.4, Merit = 0.24
0.8 1.2, Merit = 0.23
0.5 1.1, Merit =“0.14
0.7 1.1, Merit = 0.07
0.8 1.3; Merit = 0.19
0.5 0.9, Merit = 0.14
0.7 1.3, Merit = 0.07
0.7 1.5, Merit = 0.18
0.5 0.9, Merit = 0.11
0.6 1.3, Merit = 0.04
0.4 1.0, Merit = 0.13
0.3 0.9, Merit = 0.13
0.4 1.3, Merit = 0.09

.:--.,.
.~:;~.:,,” List e, El= 1028.0 120 3-gates, Mean cnts = 0.2+/- 0.4 1.0, Merit= 0.15/,+ ..-:..:...-%+ List e, El= 1030.0 120 3-gates, Mean cnts = 0.0+/- 0.3 0.5, Merit= 0.00‘. ]-.;;>..-2”-.-..J,;i.,,,.;., List f, El= ~150.O 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN:-..-,;:=.;, ,.,.:.,.:,..,,.S.y:l List f, El= 11520 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaNP:’J.:~.>G-=r.,,w:,.%.= List f, El= 1154.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN.?-,yJ,..r.-L.,.=~,.:-.. List f, El= 1156.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN,..-..-:,.7....; ;>:y
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List f, El= 1158.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1160.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1162.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
Lkt f, El= 1164.0 1203-gateS, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1166.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1168.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1170.0 120 3-gat&, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1172.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1174.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f,-El= 1176.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1178.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List f, El= 1180.0 120 3-gates, Mean cnts = 0.0+/- 0.0 0.0, Merit =NaN
List g, El= 400.0 120 3-gates, Mean cnts = -14.1+/- 23.2 83.1, Merit =-0.17
List g, El= 402.0 120 3-gates, Mean cnts = -0.2+/- 17.2 222, Merit =-0.01
List g, El= 404.0 120 3-gates, Mean cnts = 1.3+/- 16.9 15.8, Merit = 0.08
List g, El= 406.0 120 3-gates, Mean cnts = 3.0+/- 23.7 58.2, Merit = 0.05
List g, El= 408.0 120 3-gates, Mean cnts = 2.0+/- 28.3 65.5, Merit = 0.03
List g, El= 410.0 120 3-gates, Mean cnts = -1.8+/- 15.9 25.5, Merit =0.07
List g, El= 412.0 120 3-gates, Mean cnts = 20+/- 15.1 16.5, Merit = 0.12
List g, El= 414.0 120 3-~ates, Mean cnts = 11.8+/- 18.0 65.6, Merit = 0.18
List g, El= 416.0 120 3-gates, Mean cnts = 5.6+/- 16.1 33.6, Merit = 0.17
List g, El= 418.0 120 3-gates, Mean cnts = 1.8+/- 16.9 74.2, Merit = 0.02
List g, El= 420.0 120 3-gates, Mean cnts = -1.2+/- 19.3 34.1, Merit =-0.03
List g, El= 4220 120 3-gates, Mean cnts = -0.5+/- 20.7 35.3, Merit =0.01
List g, El= 424.0 120 3-gates, Mean cnts = -3.4+/- 20.7 38.9, Merit =0.09
List g, El= 426.0 120 3-gates, Mean cnts = -15.6+/- 20.3 70.1, Merit =-0.22
List g, El= 428.0 120 3-gates, Mean cnts = 3.5+/- 23.0109.9, Merit = 0.03
List g, El= 430.0 120 3-gates, Mean cnts = -1.3+/- 26.8185.0, Merit =-0.01
List g, El = 432.0 120 3-gates, Mean cnts = -14.1+/- 23.1 83.2, Merit =-0.17
List h, El= 560.0 120 3-gates, Meap cnts = 0.9+/- 13.0 14.5, Merit = 0.06
Lkt h, El= 562.0 120 3-gates, Mean cnts = 1.7+/- 12.2 15.3, Merit = 0.11
List h, El= 564.0 120 3-gates, Mean cnts = 0.3+/- 13.5 17.6, Merit = 0.02
List h, El= 566.0 120 3-gates, Mean cnts = -0.8+/- 15.4 227, Merit =-0.03
List h, El= 568.0 120 3-gates, Mean cnts = 0.7+/- 127 15.7, Merit = 0.04
List h, El= 570.0 120 3-gates, Mean cnts = -0.5+/- 11.2 11.6, Merit =-0.04
List h, El= 572.0 120 3-gat&, Mean cnts = 20+/- 11.7 124, Merit = 0.17
List h, El= 574.0 120 3-gates, Mean cnts = 22+/- 11.2 11.3, Merit = 0.20
List h, El= 576.0 120 3-gates, Mean cnts = 1.2+/- 11.7 18.5, Merit = 0.06
List h, El= 578.0 120 3-gates, Mean cnts = -0.4+/- 129 16.3, Merit =-0.02
List h, El= 580.d 120 3-gates, Mean cnts = 20+/- 11.3 12.6, Merit = 0.16
List h, El= 5820 120 3-gates, Mean cnts = 1.5+/- 10.0 10.4, Merit = 0.14
List h, El = 584.0 120 3-gates, Mean cnts = -1.4+/- 11.4 13.4, Merit =-0.10
List h, El= 586.0 120 3-gates, Mean cnts = -27+/- 125 19.7, Merit =-0.13
List h, El= 588.0 120 3-gates, Mean cnts = 2.3+/- 14.0 23.3, Merit = 0.10
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List h, El= 590.0 120 3-gates, Mean cnts =
List h, El= 592.0 120 3-gates, Mean cnts =
List i, El= 720.0 120 3-gates, Mean cnts =
List i, El= 7220 120 3-gates, Mean cnts =
List i, El= 724.0 120 3-gates, Mean cnts =
List i, El= 726.0 120 3-gates, Mean cnts =
List i, El= 728.0 120 3-gates, Mean cn@ =
List i, El= 730.0 120 3-gates, Mean cnts =
List i, El= 732.0 120 3-gates, Mean cnts =
List i, El= 734.0 120 3-gates, Mean cnts =
List i, El= 736.0 ~20 3-gates, Mean cnts =
List i, El= 738.0 120 3-gates, Mean cnts =
List i, El= 740.0 120 3-gates, Mean cnts =
List i, El= 742.0 120 3-gates, Mean cnts =
List i, El= 744.0 120 3-gates, Mean cnts =
List i, El= 746.0 120 3-gates, Mean cnts =
List i, El= 748.0 120 3-gates, Mean cnts =
List i, El= 750.0 120 3-gates, Mean cnts =
List i, El= 752.0 120 3-gates, Mean cnts =
List j, El= 880.0 120 3-gates, Mean cnts =
List j, El= 8820 120 3-gates, Mean cnts =
List j, El= 884.0 120 3-gates, Mean cnts =
List j, El= 886.0 120 3-gates, Mean cnts =
List j, El= 888.0 120 3-gates, Mean cnts =
List j, El= 890.0 120 3-gates, Mean cnts =
List j, El= 8920 120 3-gates, Mean cnts =
List j, El= 894.0 120 3-gates, Mean cnts =
List j, El= 896.0 120 3-gates, Mean cnts =
List j, El= 898.0 120 3-gates, Mean cnts =
List j, El= 900.0 120 3-gates, Mean cnts =
List j, El= 9020 120 3-gates, Mean cnts =
List j, El= 904.0 120 3-gates, Mean cnts =
List j, El= 906.0 120 3-gates, Mean tits =
List j, El= 908.0 120 3-gates, Mean cnts =
List j, El= 910.0 120 3-gates, Mean cnts =
List j, El= 9120 120 3-gates, Mean cnts =

22+/-
l.l+/-

0.6+/-
o.2+/-
l.3+/-
0.8+/-
l.o+/-
o.7+/-
o.9+/-
0.6+/-
0.6+/-
21+/-
l.7+/-
l.5+/-
o.o+/-
l.2+/-
o.4+/-
o.o+/-
o.9+/-
o.2+/-
o.4+/-
0.8+/-
0.6+/-
Ll.6+/-
l.o+/-
0.8+/-
l.o+/-
l.o+/-
0.8+/-
0.6+/-
0.8+/-
l.o+/-
L3+/-
o.4+/-
o.4+/-
o.4+/-
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List k, El= 1040.0 120 3-gates, Mean cnts =
List k, El= 1042.0 120 3-gates, Mean cnts =
List k, El= 1044.0 120 3-gates, Mean cnts =
List k, El= 1046.0 120 3-gates, Mean cnts =
List k, El= 1048.0 120 3-gates, Mean cnts =
List k, El= 1050.0 120 3-gates, Mean @s =
List k, El= 1052.0 120.3-gates, Mean cnts =
List k, .El= 1054.0 120 3-gates, “Mean cnts =

o.l+/-
o.l+/-
o.l+/-
o.l+/-
o.l+/-
o.l+/-
o.l+/-
o.2+/-

13.8 21.8, Merit = 0.10
123 13.4, Merit = 0.08
6.4 6.0, Merit = 0.10
6.2 5.7, Merit =-0.04
6.1 6.3, Merit = 0.21
6.5 7.3, Merit = 0.11
6.2 6.1, Merit = 0.17
5.7 5.9, Merit = 0.12
6.1 6.1, Merit = 0.15
5.9 6.4, Merit = 0.09
5.6 5.3, Merit = 0.12
6.1 6.0, Merit = 0.35
5.9 6.8, Merit = 0.26
5.5 5.2, Merit = 0.29
5.8 5.5, Merit = 0.00
5.7 4.9, Merit = 0.24
5.2 4.7, Merit = 0.09
5.6 5.8, Merit = 0.00
5.6 4.8, Merit = 0.18

29 3.2, Merit= 0.06
3.1 3.5, Merit = 0.11
3.0 3.0, Merit = 0.27
29 28, Merit= 0.22
3.0 3.1, Merit = 0.20
28 29, Merit = 0.35
2.8 29, Merit = 0.28
29 27, Merit = 0.37
29 3.0, Merit= 0.33
28 3.1, Merit = 0.25
2.9 3.1, Merit = 0.19
29 28, Merit = 0.27
2.7 3.1, Merit = 0.32
29 3.1, Merit= 0.43
2.7 2.7, Merit = 0.16
2.4 2.5, Merit = 0.14
24 28, Merit= 0.14

0.3 0.9, Merit = 0.07
0.2 0.7, Merit = 0.17
0.2 0.4, Merit = 0.20
0.2 0.6, Merit = 0.13
0.2 0.8, Merit = 0.17
0.2 0.5, Merit = 0.24
0.2 0.6, Merit = 0.12
0.2 0.7, Merit = 0.24



List k, El= 1056.0 120 3-gates, Mean cnts =
List k, El= 1058.0 120 3-gates, Mean cnts =
List k, El= 1060.0 120 3-gates, M&m cnts =
.List k, El= 10620 120 3-gates, Mean cnts =
List k, El= 1064.0 120 3-gates, Mean cnts =
List k, El= 1066.0 120 3-gates, Mean cnts =
List k, El= 1068.0 120 3-gates, Mean cnts =
List k, El= 1070.0 120 3-gates, Mean cnts =
List k, El= 1072.0 120 3-gates, Mean cnts =

o.2+/-
o.l+/-
o.l+/-
o.o+/-
o.l+/-
o.l+/-
o.o+/-

-o.l+/-
o.o+/-

0.2 0.8, Merit = 0.20
0.2 0.8, Merit = 0.17
0.2 0.9, Merit = 0.10
0.2 0.4, Merit =-0.06
0.2 0.6, Merit = 0.18
0.2 0.6, Merit = 0.14
0.2 0.6, Merit = 0.00
0.1 0.4, Merit =-0.15
0.1 0.4, Merit =-0.01
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The Madam application defines three types of objects which are

actually composites of many Motif widgets. The three types of objects are

MadamWind, HistWind, and PanelWind. All three objects follow the same

basic construction architecture. As can be seen in the Figure Cl, each object

has a top level widget as a base widget that interacts with the operating

system. Placed on top of this base is a Motif main window widget. Widgets

of this type may contain up to five areas and Madam makes use of three of

those areas. Madam makes use of the menu bar, the work region, and the

message window. Madarn does not use the command window area or the

scroIl bar area of the main window widget.

The MadamWind object, the HistWind object, and the PanelWind object

each place a menu bar widget in the Motif main window widget’s menu bar

area located at the top of the main window and, therefore, at the top of the

object. All three objects also place a message bar widget in the Motif main.

window widget’s message area located at the bottom of the main window

and, therefore, at the bottom of the object. The message bar widget is a

composite of many Motif widgets and is used to allow Madam to send

messages to the base of any object. As was stated above, the three objects also

make use of the work

the mid-section of the

region of the main window widget which is located in

object between the menu bar widget area and the

message bar area. The object makes use of this region by attaching a widget to
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Figure C.1 Madam’s object design. A top level widget interacts with the operating system and has a Motif main
window widget as a child of the top level widget. Madam then makes use of the main window’s
menu bar, work, and message areas.
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the main window’s work area. However, the widget that is placed in this area

differs for each type of object.

The menu bars of each”object contains menus that operate on that

specific object. The first foti menus on the menu bar of all three objects are

the “Fiie” menu, the “Edit” menu, the “View” menu, and the “Options” menu.

The last menu item on each of the objects is the “Help”menu. The items listed

under these menus may vary from object to object. Additional menus maybe

added to the menu bar which would reflect that objects unique features.

The menus of the menu bars maybe activated by either using the left

most button on the mouse or by using mnemonic keys provided by the Motif

tool kit. Many operating systems also allow the user to define keys that will

let the user move the mouse pointer with keyboard keys instead of the mouse.

These two features together allow the user to access many of Madam features

while bypassing the mouse alI together. The specifics of each object’s menu

bar will be discussed

dissertation.

at length when the object is discussed later in this

The MadamWind Obiect.

The MadamWind object is the first object that the user will see when the

madam program is launched and is the main controlling window of the

application. As was stated above, the work areas in the mid-section of the

objects differ for each type of object. The work area of the MadamWind object,

which can be viewed in F@ire C.2, contains a fully editable, scrolling text
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widget. The text widget serves as a worksheet for the user with both text

editor and shell like behaviors. The other Madam objects are able to send

ASCII output to the scrolling text widget thereby allowing for the generation

of summaries and reports which can be. saved as standard ASCII files.

Using the text widget, the user can also pass commands to the shell

preceding the com&nd with a exclamation mark ‘!’. The commands are

by

handled through a popen function call, which actually forks a child process and

executes that process allowing for communication through a pipe. A

command executed in this manner blocks until the child process has exited.

While the command is executing it is allowed to pass data back to Madarn

which then decides where to send the output.

The MadamWind’ object is also. able to understand internal Madam

commands. These coremands allow the user to type various Madam specific

commands bypassing the graphical user interface. The internal commands do

not have any escape characters preceding them. Both shell commands and

internal Madam commands can appear on a line by themselves or on the same

line separated with a semi-colon. ‘~. If”the commands are on multiple lines

they can also be highlighted by using the select button (left most button) on

the mouse or by pressing the “Shift” key then using the arrow keys with the .

shift key still depressed. The commands can be executed with the “Enter” key

on the numeric keypad. This is necessary because the MadamWind object’s
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. . I

Figure C.2 Madam’s MadamWind object. A menu bar widget can be seen
at the top of the object while a message bar widget can be seen
at the bottom of the object. The center of this object captains a
scrolling text widget.. .



text widget is a fully editable text widget. Therefore, the “Enter”

standard key pad is reserved for the new line, “\”n”,character.

195

key of the

Madam users can further interact with the Madam application by using

the menu bar located at.the top of the MadamWind object as seen in Figure

C.2. The menu bar contains the following five menus the “Fde”menu, the

“Edit” menu, the “View” menu, the “Options” menu, and the “Help” menu.

Each of the five menus contains several menu items. The “Fiie” menu has the

following menu items on iti “New”, “Open”, “Load”, “Map”, “Save”, “Save as...”,

“Print”, and “Exit”. If the “New” menu item is selected a cascade menu will

appear on the screen with two sub-items that the user can chose from. The

first is “Control Panel...”, and the second is “Histogram...”. The three dots after

each of these items indicates that selecting this option will cause a widget to

open on the screen. If the “Control Panel...” sub-item is chosen a PaneIWind

object will open on the screen and if the “Histogram...” sub-item is chosen an

empty HiStWind object will open on the screen.

The “Open” menu item is more complex than most of the other menu

items. If this item is selected a cascade sub-menu will open on the screen.

This sub-menu will always present the user with at Ieast two sub-items “cho...”

If the user selects “cho...” a file selection dialog box will open on

the screen with its filter set to “*.cho”, thereby only listing files in the current

ith the ‘.cho’ extension. If the user selects the “txt...” option then the
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same thing will happen except that the filter will be set to “*.txt”,thereby only

listing the files in the mrrent directory with the ‘.txt’ extension.

In addition to the two permanent sub-items on the “Open” submenu, the

user may also see other sub-items. Every time the submenu of the “Open”

menu item detects a mouse enter event the Madam application reads a

directory specified in the Madam resource file for any executable files and then

dynamically adds the name of any executable files found in the directory. The

executable files located in the directory should be filter components. (See

Chapter VI for a further discussion of filter components.)

“ The “Load” menu item, if seIected, will also cause a cascade menu to

appear on the screen that contains two sub-items ‘log...” and “worksheet...”.

Both options open a file selection dialog box. The log option has the file

selection dialog box filter set to “’log” whiIe the worksheet option has the filter

set to “*mad”. Both options allow the user to load ASCII text files into the

worksheet area. The distinction between the ‘log’ and ‘mad’ file is that a ‘log’

file is meant to be used to store detailed results, procedures, and Madam

message information while the ‘mad’ files are worksheets that contain only the

most useful information for the user.

The “Map” item is another cascade menu, however it has only one sub-

! ,.;,% item, “Shared HiSt...”. This option is used to interface with shared memory.+.:-,
} -’z;<:, .;;,?.<:
I

,. .7...1: histograms stored in the LJPAK .HIS file format When this option is selected,*,.,,...,JJ~.:—.~: .,,;.-:;
p ,,s,-: a file selection dialog box opens on the screen with the filter option set to ‘.drr.,,,..
~:. :.i!;
k .’:;~r y:

~F. .,....
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A .drr file contains shared memory keys that allow Madam to access the

shared memory histograms. Madam does this by creating display specific

structures but has a pointer that points to the data stored in the shared

memory. This allows for on line monitoring of histograms while running on

Gamrnaspherey which is currently housed at

Laboratory.

The next two menu items “Save”, and

the Lawrence Berkeley National

“Save as...” will save any ted

currently in the worksheet area as an ASCII ted file. The “Save” item causes

the file to be written under its current name while “Save as...”, via a file

selection dialog box, can be used to save the text under a different name. The

default file name is “worksheet.mad”.

The “Print” menu item is currently not implemented and appears

shaded out in the “File” menu. It will be used to print the text that appears in

the worksheet area by communicating directly with a postscript printer. The

last menu item on the %le” menu is the “Exit” menu item. If selected the

entire Madam application will exit including all HiStWind objects and

PanelWind objects.

The next menu on the menu bar is the “Edit”menu which has five iterns
+*

:<~
:.:.* on it. The items are “Undo”, “Again”, “Cut”, “copy”, and “Paste”. However,

-, .;.,~“f<, $.& “Undo” and “Again” are not implemented yet and appear shaded out in the‘~;,Z..:
; ;$~-~ “Edit” menu. The “Cut” item allows a section of the worksheet that has been:<.‘
~L’i::;~:
0 :’3.:. ,”,,. T., selectd’ to be cut from the worksheet and stored in a buffer regulated by the,.,,
i:-‘3;
~ ,:~+
f“::%
~, ,.?,, ,;,sc
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operating system. The “Copy” item will cause a selected portion of the

worksheet to be copied into an operating system buffer but remain in the

worksheet. The “Paste” item “willcause any text stored in the operating system

buffer to be pasted into the worksheet at the current insertion point.

The “View” menu is the third menu on the menu bar and contains four

items. None of these options are implemented yet and they appear shaded

out. The “Options” menu is the fourth menu on the menu bar and is currently

not implemented. “

The last menu item on the MadamWind object’s menu bar is the “Help”

menu. The iterns of this menu include the “Developers Guide”, the “User

Manual”, the “Keys”, the’ ‘Window Objects”, the ‘Tutorial”, the “Version”, the

“CHO Manual”, and the “Known Bugs”. Selection of any of these items will

restilt in a help dialog widget opening on the screen. The dialo~ as seen in

Figure C.3, has a list widget in the upper left comer listing the available help

topics. Directly beneath the list widget are four buttons labeled “Show Me”,

“Back”, “Close”, and “Print”. The Pr&t button is currently not implemented

and appears shaded out. To the right of the list widget and the button widget

area is a non-editable text widget used to display ASCII text help files.

The user may view the help files by selecting an object in the list widget

and then pressing the “Show Me” button. The help file may also be viewed by

double clicking an item in the list widget. Madarn will keep a history of the

last 10 selections and will allow the user to back through the list by pressing
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FIguxe C.3 Madam’s help dialog widget contains a list widget, a button
area, and a non-editable scrolling text widget.
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the “Back” bufton. When the Help dialog widget is first opened the “Back”

button is shaded and not sensitive-to the user. However, once a help file is

viewed the “Back” button will become active and responsive to the user. The

“Close” button will remove the help dialog widget from the screen.

All of the menus and menu items can be accessed with mqemonics.

Mnemonics are characters that allow the user to activate the menus without

using the mouse. To use the mnemonics the user can depress and keep down

the left Alt key and then type the underlined character of the menu that is

needed. Once the menus are activated the depressed keys can be released and

the menu that popped up when activated will remain on the screen. The .

menu items can then be activated by typing the underlined character of the

desired item.

The HistWind Obiect

The HistWind object, whkh is shown in Figure C.4, is used to view and

manipulate the histogram data. As noted, the work area widgets located in

the mid-section of the objects are the defining aspect of the three objects. The

widget contained in the mid-section area of the H~tWind object is a drawable

widget. Madam uses a series of CHO library calls to render the histogram

data to the screen. Madam has the ability to render 1 and 2 dimensional

histograms.

Like the MadamWind object the HistWind object allows the users to

‘ interact with the histogram data via a menu bar, mnemonic keys and, unlike
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Figure C.4 Madam’s HistWind object. A menu bar widget can be seen at
the top of the object w~e a message bar tidget can be
seen at the bottom of the object. The center of this object
captains a drawable widget. ”
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the MadamWind object, with accelerator keys. Accelerator keys allow the user

to invoke certain Madam actions with a combination of keystrokes. (See

Appendix D.) The HiStWind object’s menu bar has the following menus the

“File” menu, the “Edit” menu, the “View” menu, the “Options” menu, the

“Objects” menu, the “AIMIySiS”menu, and the “Help” menu. The “INe” menu

items are similar to the “File” menu items in the MadamWind object, however,

there are some important differences. The HistWind’s “File” menu items

include the “New” item, the “Open” item, the “Load” item, the “Save” item, the

“Save as...“ item, the “Print” item, and the “Quit” item.

‘ If the “New” menu item is selected a cascade menu will appear on the

screen containing only one sub-item, “Histogram...”. If this option is selected

by the user an em@y HiStWind object will open on the screen. The “Open”

itern is exactly the same as the “Open” item in the MadamWind object. Recall

that this submenu is built dynamically by checking a specific directory for

executable files which are then added as menu items to the submenu. The

“Load” menu item works the same as the “Open” menu item except that

instead of opening a new HiStWind object, the current objects discards the

current histogram data that it is rendering and loads the chosen histogram into

memory and renders it on the screen.

The “Save” menu item will save the current histogram under the current

file name in the CHO file format. The “Save as” submenu items are built in

the same reamer as the “Open” submenu items, but instead of opening a new
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HistWind Object, it will allow the user to save the current histogram under a

different name and under a chosen file format. (See Chapter VI for more

information on filter components.) The “Print” menu item is currently not

implemented and appears shaded out in the “File” menu. When implemented,

the “Print” menu item will be used to print the histogram that appears in

HistWind object by communicating directly with a postscript printer. The last

item on the “File” menu is the “Quit” menu item. This menu item M cause

the HistWind object to be destroyed, but the Madam application will continue

to run.

The “Edit” menu has the same menu items as the “Edit” menu in the

MadamWind object but these menu items are not implemented” yet and appear

shaded out when the menu is activated. The “View” menu is the next menu on

the menu bar and is quite different from the “View” menu in the MadamWind

object. This menu has the following items the “Expand” item, the “Show All”

item, the “Set Cursers” item, the “Get Cursers” item, the “Set Axes” item, the

“Set Vertical” ite”m,the “Set to Log’’/’’Set to Linear” item, the “Auto Axis” item,

the “Auto Scale” item, the “Grid item, the “Symbol Fill” item, the “Reverse

Video” item, the “Symbol” item, and the “Data Color” item.

The “Set Cursers” item, and the “Set Axes”. item are not implemented

and appear shaded out when tie “View” menu is activated. The “Expand”

item sets the limits of the viewing region to the current channel position of the

cursers. ‘me “Show AU”item sets the limits of the viewing region to the length
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of the data. The “Get Cursers” item places the Cursers 50 pixels in from the

limits of the viewing region. When the “Set Vertical...” item is selected a dialog

widget opens on the screen. “There are two input areas and three response

buttons on the dialog. One “inputarea is for the low channel value and the

other input area is for the high charnel value. Madam wilI only display -

values between the value limits.

The “Set to Log” menu item will cause the data to be rendered in a log

scale plot. Once sele&ed, this item will change its label from “Set to Log” to

“Set to Linear”. If this item is selected again the plot will change back to a

linear scaled plot and the item’s label will change back to “Set to Log”. The

next menu item is the “Auto Axis” item and will toggle the plots between

automatic charnel axis scaling and manual channeI axis scaling. The “Auto

Scale” menu item allows the user to toggle between automatic value axis

scaling and manual value axis scaling.

The “Grid” menu item toggles the HistWind object between drawing the

plot with a grid and drawing without a grid. The “Symbol Fill” menu item

toggle between drawing the plot with the symbols filled or with the symbols

not filled. The “Reverse” menu item causes the plot to toggle between being

drawn in reverse video mode and regular mode.

The final two menu items of the “View” menu are actually cascade sub-

menus, one labeled “Symbol” and the other labeled “Data Color”. Under the

“Symbol” sub-menu item there are the following sub-items, “Histograms”,



205

“Dot~”,“L~@’, “squarw’t, “C~&#’, and ‘Triangles”. when selected the data

symbol is drawn with the chosen shape. Under the “Data Color” sub-menu

item there are the foIlowing sub-it-, “Black”, “White”, “Grey”, “Red”, “Green”,

and “Blue”. When selected the data is drawn

The next menu on the menu bar is the

with the chosen color.

II@o~l’ ~enu and there is

currently only one item under this menu. The item is labeled “Footer” and

when chosen causes the HiStWind object to be toggled between being

displayed with or without the footer message area. The next menu on the

menu bar is the “Objects” menu which contains six items. They are “Create

Marker”, “Edit Marker”, “Create Region”, “Edit Region”, “Create Annotation”,

and “Edit i%motation”. The last four menu items are not implemented and

appear shaded out when the menu is activated. The “Create Marker” menu

item allows the user to create a marker that is drawn on

the HiStWind object. when this itern is selected a Marker dialog widget is

opened on the screen.

The marker dialog widget allows the user to enter a marker label, a

marker data value, a marker channel value, the marker color, the marker

content, and the drawing options associated with the marker. The “Edit

Marker” item allows the user to edit the last seltied marker. When selected, a

marker dialog widget will open on the screen and will allow the user to

deleted or change the chosen marker. A marker can be chosen by moving the

mouse pointer over the marker and pr~ing the select button on the mouse.
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The n&t menu on the menu bar is the “Analysis” menu which has only

one item and it is labeled “Others”.”This menu item is actually a cascade sub-

menu that is built dynamically like the “Open” and “Save as” menu items. The

menu is built by looking for executable code in a specific directory and adding

the name of the executable programs found in the directory to the menu list.

These executable programs are analysis components. The final menu on the

menu bar of the HistWind object is the “Help” menu and is the same as the

“Help” menu of the MadamWind object.

The PanelWind Obiect

The third type of object that Madam defines is a PanelWind object.

This object is not yet distributed with the Madarn application. Therefore, this

object wiIl not be discussed here but documentation can be found at the

anonymous ftp site.
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~ ~p~~ is a Developers guide for the Madam application”

Introduction

Currently there are &ee d&~ obj~~ ~ fie Madam prOj@ ‘he

MadamWind object, the ~tw~d obj~, and fie pm~w~d object. Each

object is a self contained entity and my ~~e fiat .sp~fi~y manipulates ‘at

Objed should reside in that obj~ dir~o~. c~e that ~ operate on

multiple objects should reside in the T’ool~x directo~. Each obj~ k

composed of a toplevel window that ~s a m~~dow containing @ee

distinct areas as a child. In the ~aubm ~m we atia~ a ~~ubar as a ~d

of the mainwindow. In the a~on -a and footer mmage ara we attaCh P~e

widgets as childr&n of the ~~dow.

AU three objects dso have a fmta widget a~&~ to the pane ‘n

message area but ea& of the Wee obj~ have &fferent widg*

the

footer

attached to the pane in tie work area.

Window hierarchy

I-s menubar

top~eve~-> mainwindow -s l-> pane ->1- Vafia for the wee obje@

l‘> pane2 ->1- composite foot= ‘idgd

... .
‘ ~:?+=.
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The objects attach the following as a child of the pane in the work area:

HistWind - Drawable Widget,

MadamWind - ScolledText,

PanelWind - Manager Form.

By making each objects window a toplevel window allows for nice windowing

features such as separate ionization.
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Directorv Overview

The Madam project uses a defined directory structure to allow easy

modification of components. “The main level directory structure is diagramed

below.

madam.proj
I
v

Ill I I I I I

Cho - Contains the source code for the cho liira~.
data - Contains sample data files.
dots - Contains documentation on Madam and CHO.
madam.cmp - Directory designated for analysis components (CMPS).
madam.fil - Directory designated for filter components (FTLs).
modules - Contains source code for the CMPs and FTLs.
source - Contains source code for the Madam interface.
tools - Contains source code for various tools that interface into .cho’s.

madam.proj
I
v

source
I
v

I I I I I I

Hist&nd MadamvWind Panel~ind Toolv.x mad~.c MakeVile
madam.h worksheet.mad

HiStWind - Contains source for the Histogram Window object.
MadamWind - Contains source for the Madam Window object.
PanelWind - Contains source for the Panel Window object.
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ToolBox - Contains source for tools that operate on all objects.
madam.c - Madam source file.
madam.h - Madam header file.
Makefile - Madam make file.
worksheet.mad - Default worksheet opened in Madam.

The source code for the window objects”is contained in the directroy structure

shown above. The location of the files is as follows.

madam.proj
1

v
source “

I
v

I

HistvWind

I
v

I

Mad&Wind

I
v

h.analysis.c
h_edit_cb.c
h_file_cb.c
h_hist_cb.c
h_obj_cb.c
h_show.c
h_set_vt_d.c
h_arch_d.c
h_markers_d.c
h_buildcmps.c
h_men_init.c
h_map_d.c
h_load_shm.c
h_menues.c
his_men.h

m_tty.c
rn_load_text.c
m_edit_cb.c
m_file_cb.c
m_menues.c
m_save_text.c
m_init.c .
m_buildfil.c
m_help.c
mad_men.h

I

Pan&Wind

I
v

c_arrows.c
c_button.c
c_con_panel.c
c_dialogs.c
c_edit_cb.c
c_file_cb.c
c_gauge.c
c_labeLc
c_menu_item.c

c_menues.c
c_radio.c
c_slider.c
c_text.c
c_toggle.c
con_men.h

I
v

ToolBox

I
v

t_alter_w.c
t_color.c
t_footer.c
t_man_event.c
t_man_wid.c
t_buildmenu.c
t_dialog.c
t_help_dialog.c
constants.h
menu.h
help.h



File Description

madam.c
madam.h

m_buildfil.c
m_edit_cb.c
m_file_cb.c
m_init.c
m_load_text.c
m_menue.s.c
m_save_text.c
m_tty.c
m_help.c
mad_men.h

- Main application- loop for the @ interface portion of Madam.
- Main Header file for the Madam application.

- Build a new menubar and dynamic FIL’s menus.
- MadamWind’s edit menu callback routine.
- MadamWind’s file menu callback routine.
- Setups Madam’s main application window.
- Loads a file as ASCII text into Madam’s worksheet.
- Build a new menubar for the MadamWind.
- Saves the worksheet as an ASCII text file.
- B@lds MadamWind’s tty window.
- MadamWinds help menu callback routines.
- Header file for the HistWind’s menus.

h_analysis.c - HistWind’s analysis menu calIback routine handles CMPs.
h_ar&d.c - Builds and opens a archive dialog widget.
h_buildcmps.c - Build a new menubar and dynamic CMP’s menus. “
h_edit_cb.c - HistWind’s edit menu callback routine.
h_file_cb.c - HistWind’s file menu callback routine.
h_hist_cb.c - HistWindS view menu calIback routine.
h_load_shm.c - Load shared memory .HIS into a cho (on-line histogram).
h_map_d.c - Build a “shared memory mapped his to .cho” dialog widget.
h_rnarkers_d.c - Build a HiStWinds marker dialog box.
h_men_init.c - Initialize the HiStWinds menus.
h_menues.c - Build a HistWind’s menubar.
h_obj_cb.c - HistWind’s object menu callback routine.
h_set_vt_d.c - Build the set values dialog and handle callbacks.
h_show.c - Responsible for showing the user a histogram.
his_memh - Header file for the Hi.stWind’s menus.

c_arrows.c - Builds an arrow item for PanelWind.
c_button.c - Builds a button item for PanelWind.
c_con_panel.c - Builds PanelWind’s window and some utilities.
c_dialogs.c - Change a PanelWind item widget. Not fully implemented.
c_edit_cb.c - PaneIWinds edit menu callback routine.
c_file_cb.c - PaneIWinds file menu callback routine.
c_gauge.c - Builds a gauge item for PanelWind.
c_label.c - Builds a label item for PanelWind.
c_menu_item.c - Builds a menu item for PanelWind.
c_menues.c - Build a new menubar for the PanelWind.
c_radio.c - Builds a radio box item for PanelWind.
c_slider.c - Builds a slider item for PanelWind.

.
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c_text.c - BuiIds a text item for PanelWind.
c_toggle.c - Builds a toggle item for PanelWind.
con_men.h - Header file for the PanelWind’s menus.

t_alter_w.c “- Ater a PanelWind’s item widgets. Not Used Yet!
t_buildmenu.c - Builds menus and attach to menubar.

. t_color.c - Sets the color of a widget.
t_dialog.c - Builds a form dilog and three buttons (okay, apply, cancel).
t_footer.c - Builds footer message areas attached to the three objects.
t_man_event.c - Event handler.
t_man_wid.c - Handles various utility functions.
t_wid_info.c - Intended to store information about a widget. Not Used!
t_help_dialog.c - Builds the help dialog widgets.
constants.h - Header file”for the Madam’s constant values.
menu.h - Header file for the Madarn’s menu definitions.
help.h - Header file for the Madam’s help definitions.

FiieStructure

Each file has the following internal structure. h example of our header
structure is shown on the following page.

Head=
copyright
Authors
DESCRIPTION
functions
notes (optional)
revisions (optional)

#includes
function declarations
source code

.

.. . ‘ ..”
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Header Examde

,*

“’ Copyright (c) 1995 Mississippi State Nuclear Physics Group
**

** Redistribution and use in source and binary forms are permitted
** provided that the above copyright notice and this paragraph are
** duplicated in all such forms and that any documentation, advertising
** materials, and other materials related to such distribution and use
** acknowledge that the software was developed by Mississippi State Nuclear
** Physics Group. The name of Mississippi State Nuclear Physics Group may
** not be us~ to ~dorse or promote pr~ucts derived from this SOftWiiR

** without specific prior written permission.
** ~ ~~~ ~ PRO~ED “~ ~ ~ -OUT ANY EXPRESS

**OR IMPLIED WMRANTE3, INCLUDING, WITHOUT LIMITATION, THE
** IMPLIED WARMN13ES OF MERCHANTABILITY AND FITNESS FOR A
X*p~~~w PLIRPOSE.
**

** Atithors
**
** Charles J. Beyeir
** Rodney B. Piercey
** Peter G. Varmette
**

** DESCRIPTION
** Modular Application for Data Analysis and Manipulation (Madam)
**

** filenarne.c – filename description.
**

** functions
** functionO - function description.
**

** notes
** Not implemented yet. Fix bug.
**

** revisions
** 5/2/96 - pgvl - FiXed bug.
‘1





216

Motif menus can have mnemonics and accelerators assoaated with

them. Mnemonics help users traverse menus or select actual menu items

without having to use the mouse. Accelerators provide the user with the

ability to activate menu iten& in pulldown menus without having to display

the menu.

For example, to activate the menus using mnemonics press the Left Alt

key and the underlined letter (lower case) of the menu of chioce. After the

menu has been activated the items can be choosen by typing the additional

i underlined letters.

h example of the accelerator keys would be the sequence for

i
I

expanding a view in the HistWind object by use of Left Cntl + e. (le., jpress

the left control key and the e key simultaneously) This has the same effect as

I activating the menu item with the mouse.

I This APPENDIX contains tree structures of the mnemonic keys used for

each object. The HistWind object has accelatator keys associated with the

menu system and are listed before &e mneumonic tree structure for this

object.

Ii;
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~
~ MadamWind Obiect

accelerator keys None
I-> c Creates anew PanelWind object.
1.

I–> n -> I (Activates the New file menu item)
I I
I I-> h Creat& a new HistWind object.
I
I
1“ l->c - Opens a file selection dialog box with the
1’1 filter set to “.cho.
I I

“1–> 0-> I (Activates the Open file menu item)
I I
I I

l->t - Opens a file selection dialog box with the
filter set to *.txt.

I-> 1- Opens a file selection dialog box with the
I filter set to *log.
I

Left Alt + f -z I–z 1-> 1 (Activates the Load file menu item)
1.1
I I
I I-> w - Opens a file selection dialog box with
I the filter set to *mad.
I
I l->s - Opens a file selection dialog box with the
I I filter Set to *.drr.
I I
I–> m-s I (Activates the Map file menu item)
I
I
I–> s -z Saves the current worksheet under the current
I name.
I
I-> a -> Opens a file selection dialog box with the filter set
I to *mad.
I
I–> p -~ PMts the ~ent worksheet.
1.
I–> x -> Exits the Madam application.



l–> a->
I
I
I–>u->

Edit menu) i
I

Left Alt+ e-> l–> c->
I
I
I–> p->
I
I
I->t->
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Repeats the last edit command.

Undoes the last edit command.

Copies the selected text in the worksheet.

Pastes the text saved in the buffer.

Cuts the selected text in the worksheet.

I–>
I
I
I–>

(View menu) I (-plimented)
1

Left Alt+ v-> l–>
I
I
I–>

“l–>
I
I
I–>

(Options menu) 1 (unimpIimented)
I

Left Alt+ o-> l–>
I
I
I–>
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HiStWind Obiect

accelerator keys

ctrl+e -> Expand the region between the cursors.
ctrl+a -> Display entire histogram. .
Ctrl+l -> Toggle drawn histogram between a log plot and a .

linear (default) plot.
Ctrl+s -> Toggle drawn histogram between autoscaled

axes (default) and non-auto.
Ctrl+g -> Toggle histogram drawn with and without (default) grid.
Ctrl+f -> Toggle drawing symbols filled and unfilled (default).

LeftAlt+k -> Color drawn histogram black.
LeftAlt+w -> Color drawn histogram white.
LeftAlt+y -> Color drawn histogram grey.
LeftAlt+r -> Color drawn histogram red.
LeftAlt+g -> Color drawn histogram green.
LeftAlt+b -> Color drawn histogram blue.

I–> a->
I
I
I–>U->

(Edit menu) I
I

Left Alt+ e-> I–> c->
I
I
I–> p->
I
I
I–>t->

(Optio.ps menu)

Left Alt+ o-> I–> f->

Repeats the last edit command.

Undoes the last edit command.

Copies the selected text in the worksheet.

Pastes the text saved in the buffer.

Cuts the selected text in the worksheet.

Toggle the display to show and remove footer bar.
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l->h - Creates a new HistWind object.
I
I–> n -> I (Activates the New file menu item)
I
I
I
I
I l->c - Opens a file selection dialog box with the
I I filter set to ‘.cho.
I 1
l–> 0-> I (Activates the Open file menu item)
1 I
I I
I l->t - Opens a file selection dialog box with the
1 [ filter set to “.txt.
I
I
I l->c - Opens a file selection dialog box with the

(File menu) 1 I filter set to ‘.cho.
I I

Left Alt + f -> I-> 1-> I (Activates the Load fiIe menu item)
I I
I 1
I l->t - Opens a file selection dialog box with the
I I filter set to ‘.txt.
I
I
I–> s -> I Saves the current histogram under the current
I name.
I
I l->c - Opens a file selection dialog box with the
I I filter set to “.cho.
I I
1–> a -> 1 (Activates the Save as file menu item)
1 I
1 I
I l->t - Opens a file selection dialog box with the .
I I filter set to “.txt.
I
I-> p -> Prints the histogram on a postscript printer.
I
I-> q -> Closes HistWind object.
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i

..
Left Alt+ v->

l–s e->
I
I
I–> a->
I
I
I–> g->
1
I

–> f ->

I
I
I
1
l–> s->
I
I
I
I
I
I
I
I

,1
I
I
I
I
I
I–> c->

Expand the region between the cursors.

Show all of the spectrum

Display histogram with a grid.

Fill histogram symbols with color.

l->h - Draw histogram with histogram symbols.
I
l->d - Draw histogram with dot symbols.
I
1->1- Draw histogram with line.
1.
I (Activates the symbol item menu)
I
l->s - Draw histogram with square symbols.
I
l->c - Draw histogram with circular symbols.
I
l->t - Draw histogram with triangular symbols.

l->k - Draw histogram in black.
I
l->w - Draw histogram in white.
I
l->y - Draw histogram in grey.
I
I (Activates the color item menu)
I
l->r - Draw histogram in red.
1.
l->g - Draw histogram in green.
I
l-> b- Draw histogram in blue.
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This APPENDIX contains a sample filter component that can be used

with Madam. The code should be compiled and placed in a directory

specified in the resource file. See APPENDIX G.

**Copyright (c) 1995 Mississippi State Nuclear Physics Group
**

** Redistribution and use in source and binary forms are permitted
** provided that the above copyright notice and this paragraph are
** duplicated in all such forms and that any documentation, advertising
** materials, and other materials related to such distribution and use
** acknowledge that the software was developed by Mississippi State Nuclear
* Physics Group. The name of Mississippi State Nuclear Physics Group may
** not be used to endorse or promote products derived from this software
** without specific prior written permission.
** THIS SOIWWARE IS PROVIDED “AS IS” AND WITHOUT ANY
** EXPRESS OR IMPLIED WNWANTES, INCLUDING, WITHOUT
** LIMITATION, THE IMPLIED WAR&WTES OF MER CHANTABILITY
** AND FITNESS FOR A Particular PURPOSE.
**

** Authors
**
** Charles J. Beyer
** Rodney B. Piercey
** Peter G. Varmette
‘/

/“
** This program coverts from an !WK f&rnat histogram used by the Hollifield
** at Oak Ridge National Laboratory, into a CHO archive file. Any questions
** related to the Hollifield data formats or their software package maybe
** directed to varner@orphOl.phy.ornl.gov. CHO questions may be directed
- to rbp@nucphy5.ph.rnsstate. edu. This program requires linking with the
* cho liirary (libcho.a) available via anonymous ftp from ph.msstate.edu.
‘/
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#include cstdio.b
#include estdlib.b
#include <cho.h>

int spk2cha (char *imame, char *outname);

/“ Valid messages
*
* !#!wksh_mess: textstring
* !#!done_mess: textstring
* !#!err_m& textstring
* !#!open_mess filename
*

* Future messages
*
* !#!dlo~mess: prOmptString
*

* Usage:
*
* helloworld filename
*

“/

/********************w*******H*****ti*****-**H********HH********
*

*

*

*

*

*

*

*

*

*

*

‘/

SPK structures (I use a 4 space tab)

Format descriptiorx
spkDir - file directory
SpkHead - header preceding every hist
data - the data
SpkHead
data
...

These structures assume 1 byte chars, 2 byte shorts and 4 byte ints

typedef Struct spkDir {
char data_type[8];
int num_hists;
int end_offset; /’in two byte intervals’/
int data_info[254][2];

] Spmir;



typedef struct SplcHead {
int id;
int parm_label[3]; /“ parameter label*/
int date[3]; /’ date& time”/
int chan_l&; /* n~er of bytes in a channel’/
int length; /“ le@h of header(in 2 by@ ‘/
int empty[2]; o /’ empty variables “/
int hist_len; /’ max # channels*/
int raw_len;
int sca_len;
int bllc_size;
int min.than; /’ first than in data “/
int max_chan; /“ last &an in data “/
int calb_const[3];
int Reserved[2];
char title[40];

} SpkHead;

int main (int argc, char **argv)
/%Return values
* o: success!!!
* -1 : Unknown error
* -2 : Could not open input file
* -3 : Could not open output file
“/
{

char outname[256],
‘tmpc = NULL,
method[256];

int Val;

if ((argc != 3) I I (!argv[l]) I I (Strkn(argv[ll) > 250)) {
printf(’’!#!err_mess:Usagc %s filename Open/Save\n”, argv[O]);
exit (-l);

}.

strcpy (outname, argv[ll);
strcpy (method, argv[2~;



if( strcmp(method,’’C)pen”) == O) {

/’ maybe change file extention.
*/
if (strlen(outname) > 4) {

tmpc = outname + strlen(outname) -4;
if (!strcmp (tmpc, “.spk”)) {

strcpy (tmpc, “.cha”);
} else {

strcat (outname, “.cha”);
1

} else {
strcat (outname, “.&a”);

}

val = spk2cha (argv[l], outname);

if (!val) {
printf (“!#!wksh_messConversion of .spk to .cha was success. \n”);
printf(’’!#!open_mess: %s\n’’,outname);

}else{
pMtf (“!#!err_m~Conversion of .spk to .cha failed. \n”);

1
} else if ( stmnp(method;Save”) == O) {

printf (“!#!err_mess5ave is not impltiented yet!\n”);
-1;

] el:${=
printf (“!#!err_mess%s is an unknown method of operation to %s\n”,

method, argv[O]);
Val = -1;

}

printf(’’!#!done_messspk(cmp) is done. \n”);
exit (val);

}



.’j.~

i
:, $ SpkDir dir;:.;r.?
f

SpkHead header;
i Hist *fie_hist;:7,
#
t

%file;,+f
;j

*outfile;
int *row_ptr;,->,./ int datasize, i;!1,,,~,,...J cho_DATA *the_data;$..... char:j namebu@6];
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/* First Ad and see if we can open the files.
‘/

if ((infile = fopen(innarn e~r”)) == NULL) {
printf(’’!#!err_mess:%s could not be opened.\n”, innarne);
fclose (infile);
return(-2);

1

if ((outfile = fopen(outnarne,’’w”)) == NULL) {
printf(’’!#!err_mess:%s could not be opened.\ n”, outname);
return(-3);

}

/’ Create a new cho and read S??K header info.
“/

the_hist = (Hist *)fio_new_histO;
fread (&dir, sizeof(SpkDir), 1, Me);

‘~
j

for (i=O;izdir.nurn_hists;i++) {
fread (&header, sizeof(SpkHead), 1, infile);:./’

1

if (header.length != 64) {+..
free (the_hist);,-.j

~
printf(’’!#!err_messSPK header is too long.\n”);
return (-l);

3 }
J?.”4.%

i
/“ Create a data record and add it to the_hist.,.

+ “/,~“f the_data = (cho_DATA *)cho_calloc_data(NULL, 1, I.NT, 4,!;,:1 &header.hist_len);

~ cho_add_object (the_hist, the_data);

i,
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/“ Read the SPk data into the_hist.
‘/

row.ptr = (tit *)cho_get(f$e_hist, ChoDataRowPtr, O);
row_p = row_~ + header.rnin_chan;
datasize = (header.max_chan - header.min_&an + 1) * 4;
fread (row_~, datasize, 1, infile);

/’ Spk hists have number id’s.
‘/

sprintf(namebuf; %d.cho’’,header.id);
cho_add_object (the_hist, (ho_ARCH *)cho_creat_arch(the_hist, namebuf));

/“U fis is the first I@ we need to throw in a port record.
“/

if (i==O)
cho_add_object (the_hist, (cho_PORT *)cho_creat_port(the_hist));
cho_write (the_hist, outname, APPEND);
cho_empty_hist (the_hist);

}

return(O);

}



APPENDIX F

A MADAM ANALYSIS COMPONENT EXAMPLE

229



230

This Al?PENDIX contains a sample analysis component that can be used

with Madam. The code should be compiled and placed in a directory

specified in the resource file. See APPENDIX G.

/’
**Copyright (c) 1995 Mississippi State Nuclear Physics Group
**

** Redistribution and use in source and binary forms are permitted provided
“’ that the above copyright notice and this paragraph are duplicated in all such
** forms and that any documentation, advertising materials, and other
** materials related to such distribution and use acknowledge that the software
** was developed by Mississippi State Nuclear Physics Group. The name of
- Mississippi State Nuclear Physics Group may not be used to endorse or “
** promote products derived from this software without specific prior written
** permission.
““ THIS SOFIWARE IS PROVIDED “AS IS” AND WITHOUT ANY EXPRESS
**OR IMPLIED W~, INCLUDING, WITHOUT LIMITATION, THE
** IMPLIED WARMNTES OF MERCHANT ABIMTY ‘AND FITNESS FOR A

“** pmmmm PURPOSE.
“1

P
- This is an analysis module to calculate the full width half max, a centroid,
3* and the area of a peak in a single CHO file (not an archive). This module
** then builds a Gaussian peak based on the peak parameters obtained. CHO
** questions maybe directed to rbp@nucphy5.ph.msstate.edu. This program
** requires linking with the cho library (libcho.a) available via anonymous ftp
- from ph.msstate.edu.
‘/

.



#include cstdio.b
#include atdlib.b
#include unath.h>
#include echo.h>

int pealdnfo (Hist *the_hist, float *FWHM, float *centroid, int *area);
. int buildGauss (Hist *out_hist, float FWHM, float centroid, int Iength,int area);

/% Vafid messages
*
* !#!wksh_mess:
* !#!done_mess:
* !#!err_mess
* !#!open_mess
*

* Future messages:
*
* !#!dlog_mess
*

promptstring

textstring
textstring

textstring
filename

* Usage
* hel.loworld filename
“/

int main (int argc, &r *%rgv)

1“ Return values
*

* o: success!!!
*. -1 : cho structure error
* -2 : filename or usage error.
*

‘/
t

Hist *the_hist, *out_hist;
*outfile;

int . length = 8192;
int val;

int area;
float ~FWHM, centroid;

if(argc != 2) {
printf(’’!#!err_mess:Usage %s filen&ne\n”, argv[O]);
exit (-2);

}
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/’ First check and see if we can open the file.
*I

switch (cho_check_file (argv[ll))
{

case -2
/“ Error - not ported “/
printf(’’!#!err_mwSP0RT record for file %s do= not ~at~ t&

system\n”, argv[l]);
exit (-l);

case -1:
/* incorrect file format’/

printf(’’!#!err_mess:%s does not appear to be a cho file.\n”, argv
exit (-l);

case O:
/“ unable to open the file for reading’/

printf(’’!#!err_mess:%s could not be opened.\ n”, argv[l]);
exit (-2);

case 1:
/“ single cho file’/
the_hist = (Hist *)cho_new_histo;
cho_load_cho(the_hist, argv[ll);
break;

case k
/“ Cho archive file ‘/
printf(’’!#!em_mess:%s is a cho archive file.\n”, argv[l]);
exit (-2);

default
/“ Should never get here “/
pw~~~#!a_m~s:&o_&~_flc in case defa~t\n”);

.

} “
/* Check the ra& word size, and data format.
“/

if (cho_get(the_hist, ChoRank, fiL) != 1) {

}

}

l]);

print@’!#!err_mess%s only works with a rank 1 cho %s is a rank %d.\n”,
argv[O], cho_get(the_hist, ChoRank, NULL));

exit( -l);
else if (cho_get(the_hist, ChoWordSize, NULL) != 4) {

printf(’’!#!err_mess:%s only works with word size = 4.\n”, argv[O]);
exit( -l);

else if (cho_get(the_hist, ChoDataForrnat, NULL) != INT) {
printf(’’!#!err_rness:%s only works with integer data.\n”, argv[Ol);—
exit( -l);

}



/“ Get peak information.
“/

val = pealdnfo (the.hist, &FwHM, &centroid, &area);
if (Val)

printf(’’!#!err_mess:%s peakInfo produced an error!\n”, argv[Ol);

/“ Open input file as the output file.
“/

if ((outfile = fopen(argv[l]~w”)) == ML) {
printf(’’!#!err_mess:%s could not be opened.\n”, argv[ll);
exit(-2);

}

/* Createan output hist and add a data, parm, dspl, and xrefs structures.
“/

out_hist = (Hist *)cho_new_histO;
cho_add_object(out_hist, cho_caUoc_dati(out_hist, 1, W, 4, Men@h));
cho_add_object(out_hist, @ho_creat_def_p-(out_tist, leq@, 1));
cho_add_object(out_hist, &o_creat_def_dspUout_W));
out_hist->xrefs_ptr = .(x_refs *)calloc(l,sizeof(x_refs));

/’ Build a simple Gaussian with the peak information.
‘/

val = buildGauss (out_hist, FWHM, centroid, length, area);
if (Val)

printf(’’!#!em_mess:%s buildGauss produced an error!\ n”, argv[O]);

/“ Write the out_hist to the disk.
“/

cho_write(out_hist, argv[ll, NEW);
close(outfile);

/’ TellMadamto open the Gaussian we built.
“/

printf(’’!#!open_mess%s\n’iargv[l ]);
printf(’’!#!done_mesxHelloworld(-p) is done. \n”);

exit (Val);
}



/* Get the centroid of the peak. .
‘/

than = lcur;
counts = row_ptrncur];
do {

Chan++;
counts += row_ptr[chan];

} while (!( (counts > rint(cSum/20)) I

I*
**This is an analysis module to calculate the full width half max of
**a peak in a single CHO file (not an archive). CHO questions maybe
directed
““to rbp@nucphy5.ph.msstate.edu. This program requires linking with the
**cho library (libcho.a) available via anonymous ftp from ph.msstate.edu.
“/
int peakhfo (Hist *tie_hist, float *FWHM, float *centroid, int *area)
/* Return values:
* o: success!!!
“/
{

int *row_ptr;
int lcyr, hcur;
int CSum;
int lcounts;
int rCounts;
int max;
int counts;
int holdChannel;
int Chan;
float lHchan;
float rHClmn;
int backCounts;

/“ Get a data row ptr, the low and high cursor charnel position.
“/

row_ptr = (int *)cho_get(the_hist, ChoDataRowPtr, O);
lcur = cho_get(the_hist, ChoCursMin, 1);
hcur = cho_get(the_hist, ChoCursMax, 1);

/“ Get the sum between cursors.
“/

CSum = O;
for (than = lcur; than e= hcur; than ++) CSum += row_ptr[chan];

(chin == hcur) ));



/“ check for zero divide.
“/

if (row_ptr[chan] != O)
*centroid = (float)chan -(( (float)

(float)row_ptr[chan]) + 0.5;
else
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(counts-Mt(csum/20)) ) /

*centroid = O; /* Store the chaqnel value.
“/
holdc’hannel = than;

/’ Get the Area of the peak.
“/

rcounts = row_ptr[hcur];
lCounts = row_ptrncur];
*area = Csum - Mt((hcur-lcur +I)”(lcounts + rcounts)/2:o);

/“ Get the FW3M of the peak-
“/

than = holdchannel;
max = row_ptr[chan];
if (max e row_ptr[chan-1]) max = .row_ptr[chan-ll;

backCounts = rint(( row_ptrHcur] + row.ptdhcur] )/2.0);
counts = rint((max - backCounts)/20);

than = lcm;
do {

Chan++;
} while (!( ((row_ptr[chan]- backcounts) > counts) I I (than == hcur) ));

if ((row_ptr[chan] - row_3tr[chan-1]) != O)
lHChan = than - (row_ptr[chan]- backCounts - counts) /

((float)(row_ptr[chanl - row_ptr[chan-ll));
else

lHChan = O;

than = hcur;
do {

than—;
} while (!( (row_ptr[chan]- backCounts > counts) I I (than == lcur) ));



if ((row_pti[chan] - row_ptr[chan+ll) != O)
rHChan = than + (row_ptr[chan]- backCounts - counts) /

( (float)(row_@[chan] - row_ptr[chan + 1]) );
else

rHChan = O;

*FWHM = rHChan - lHChan;

/“ Write the information to the Madamworksheet.
“1
pMtf (“!#!wksh_mesxLcursor channel position = %i\n’’,lcur);
prhtf (“!#!wksh_mess:Rcursor channel position = %i(n’’,hcur);
printf (“!#!wksh_messLcursor contents = %i\n’’,row_ptrPcur]);
printf (“!#!wlcsh_messRcursor contents = %i\n’’,row_ptrhcur]);
pMtf (“!#!wksh_messSUM = %i\n”, cSum);
pMtf (“!#!wksh_messcentroid = %fin’’,’centroid);
printf (“!#!wlcsh_mess:area = %i\n”, *area);
printf (“!#!wksh_mes@WFRvf = %fin’’,*FWHM);

return(0);
.

int buildGauss (Hist *out_hist, float FWHM, float centroid, int length, int area)
{
int i;
long *data_row;
float sigma, sig_2, A, PI;

/“ Btid a simple Gaussian and using the parameters obtained
from pealdnfo then write the Gaussian as a cho file and
tell Madamto open it.

“/
sigma = FWHM/2.35;
sig_2 = pow(sigma,2);
PI = 3.14159;
A = area / (sigma* sqrt(2*PI));

data_row = (long *).do_get(out_hist, ChoDataRowI%r, O);
for (i=o;i<length;i++) { ~
“ data_row[i] = tint(A*pow(&ONST_E,-(pow((iwentioid),2)/(2*si~2))));
}

return(O);
}
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